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Installing ABBYY FlexiCapture 10 

Before purchasing the product, analyze your document processing needs and select either the local or the distributed version. 
If you plan to process moderate amounts of documents (approximately 5,000 pages per day), employ one or two operators for the 
job, and do not require any sophisticated batch routing, then Local Installation is the best choice. 
If you plan to automate data capture and processing, require sophisticated batch routing based on document or batch types, and 
need a scalable pool of centrally administered workstations, then select Distributed Installation. 
Note: When installing the program under Windows Vista, Windows 7, Windows Server 2008 or Windows Server 2008 R2 opera-
tions systems, the UAC must be disabled before installation or the native administrator account must be used. 
Important! The distributed and local versions cannot be installed on the same computer. 

Standalone Installation 
The following installation methods are available to install the standalone version of ABBYY FlexiCapture: 

• manually (interactive installation) 

• from the command line 

Interaction of the system components 
The following figure displays the system component interaction for standalone installation: 

 

Licensing Server
TCP/IP 10040

FlexiLayout
Studio

FormDesigner

Operator StationAdministrator 
Station

 
 
If you have one license and several operator stations, then for connecting operator stations to the Licensing Server, the 10040 port 
has to be opened manually in Firewall settings. 

Manual (interactive) installation 
To install the standalone version of ABBYY FlexiCapture: 

1. In the Autorun menu, select Standalone Installation (you can run the autorun.exe file manually). 

2. Select a setup language. The setup program will compare the locale of your system and the selected language. If the lan-
guages are incompatible, a warning message is displayed. 

3. Next, the setup program checks the version of your operating system and the availability of the administrative permis-
sions. If the version of the operating system is not supported by the program or you do not have the administrative per-
missions, a warning message is displayed and the setup program is terminated.  

4. If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement 
carefully and if you agree with the terms of the agreement, select the corresponding option and click Next. 

5. A dialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation. 

6. In the next dialog box, select one of the available installation modes:  

• Administrator Station – The setup program installs the Administrator Station, FormDesigner 10, and FlexiLayout 
Studio 10. 

• Operator Station – The setup program installs only the Operator Station. (The Administrator Station, FormDe-
signer 10 and FlexiLayout Studio 10 will not be installed). 
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• Administrator and Operator Station – The setup program installs the Administrator Station, the Operator Station, 
FormDesigner 10 and FlexiLayout 10. By default this configuration is installed. 

7. Next, select a destination folder. By default, the program is installed to %systemdrive%\Program Files\ABBYY Flex-
iCapture 10. If there is not enough space on the selected hard disk, a window is displayed showing your hard disks, the 
available free space, and the space required by the installation. Select a disk with sufficient free space and continue with 
the installation. 

8. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a 
message saying that the application has been successfully installed. 

9. FlexiCapture 10 License Manager will be launched automatically so that you can activate your serial number. See the 
Managing Licenses section for details. 

Note: For information about configuring multiple workstations to work with a single license server, see “Connecting stations to 
the Protection Server”. 

Command line installation 
In the default configuration, all recognition languages are installed on the local computer and the interface language is selected 
automatically based on the regional settings of the computer on which the program is installed. The default configuration includes 
the Administrator and Operator stations, guides, help files, ABBYY FlexiLayout and ABBYY FormDesigner tools and FlexiCap-
ture 10 License Manager. 
Run the setup.exe file located in the administrative installation folder using the command line options described below. 

Advertise installation 
For advertise installation, type 
Setup.exe /j 
The stations icons will appear in the Start menu. Clicking this icon automatically installs the program in default configuration. 
Clicking the Administrator Station icon installs the Administrator Station, guides, help files, ABBYY FlexiLayout and ABBYY 
FormDesigner tools and FlexiCapture 10 License Manager. 
Clicking the Operator Station icon installs the Operator Station, help files and FlexiCapture 10 License Manager. 

Silent installation 
In the case of silent installation, no setup dialog boxes are displayed and the program is installed in default configuration. 
Setup.exe /qn 
Change “/qn” to “/qb” if you want an installation progress bar to be displayed. 
No other dialog boxes will be displayed. 
Additional command line options 
/L<language code> disables auto selection of the interface language and installs the program with the interface language you spe-
cified. 
The following language code values are available: 
1033 English 
1049 Russian 
1031 German 
1036 French 
2052 Chinese simplified 
1040 Italian 
1034 Spanish 
2074 Serbian 
1029 Czech 
1038 Hungarian 
1045 Polish 
1046 Portuguese (Brazilian) 
1042 Korean 
/V <command line> passes the specified command line directly to msiexec.exe. The <command line> string can be replaced with 
the following commands: 
INSTALLDIR="<destination>" – the path to the folder where ABBYY FlexiCapture 10 is to be installed. 
SETUPTYPE_CMD="<install mode>" – available installation modes. 
The following modes are available: 
Full – Full installation (the Administrator and the Operator Stations, guides, help files, ABBYY FlexiLayout and ABBYY Form-
Designer as well as License Manager will be installed) 
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Admin – Administrator Station (the Administrator Station, guides, help files, ABBYY FlexiLayout and ABBYY FormDesigner  
as well as License Manager will be installed) 
Operator – Operator Station 
Example: 
Setup.exe /qn /L1049 /v INSTALLDIR="D:\FC10" SETUPTYPE_CMD=Full  
As a result, the Administrator and Operator Stations will be installed into D:\FC10, and Russian will be used the language of the 
interface. 
Removing ABBYY FlexiCapture in silent mode 
msiexec /x { FC100000-0004-0000-0000-074957833700} 

Distributed Installation 
For distributed installation, it is recommended that a server operating system should be used. Windows XP, Windows Vista and 
Windows 7 are not server operating systems. They support only a limited number of connections and are not well suitable for 
server use. 
The following three steps are required to install the distributed version of ABBYY FlexiCapture: 

1. Prepare the Application Server. 

2. Install the servers. 

3. Install the workstations. 

Preparing the Application Server for installation on Windows 2008 R2 
This instruction can also be used when installing the Application Server on Windows 2008, Windows 7 and Windows Vista. 
Important! Before you start, disable the UAC or perform all actions using the native administrator account. 
To disable UAC: 

1. In Control Panel open User Accounts. 

 
2. Click Change User Account Control settings link and in the dialog box that opens, decrease the level of user control 

to Never notify. 



 

© 2011 ABBYY. All rights reserved. 8 

 
3. For changes to take effect, restart the computer after turning off UAC. 

 
The distributed installation of FlexiCapture 10 includes three servers: 

• Application Server 

• Protection Server 

• Processing Server 
The Application Server coordinates the work of the stations ensures the correct operation of ABBYY FlexiCapture 10. The fol-
lowing components must be installed on your computer before you can install the Application Server: 

• Net Framework 3.5 
By default this component is included in Windows 2008 R2 (except the version Core). It must be installed via Server Manager -> 
Features –> Add Features. 
To install .Net Framework 3.5, do the following: 

1. In My Computer local menu, choose Manage. 
2. In the Server Manager console that opens, choose Features. In the right window click Add Features and from the fea-

tures list select .Net Framework 3.5.1 Features.  
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3. The dialog box that opens will prompt you to add features required for installation of .Net Framework 3.5.1. In this 
window, click Add Required Features 

 
 

4. In the next step, click Install. 



 

© 2011 ABBYY. All rights reserved. 10 

 
 

5. During installation, Windows may ask for the source distribution files, so you need to have Windows installation CD. 
On other operating systems, (Windows 2008, Windows 2003) this component can be installed by selecting Install External Com-
ponents in the Autorun menu. 
Note: You can find information about the installed versions of Net.Framework in the registry. For more information, please refer 
to the Microsoft web-site. 

• IIS (Internet Information Services) 

The Application Server can only be installed on a computer on which Microsoft Internet Information Server 5.1 or later is in-
stalled. IIS is required for the correct operation of the Application Server, the Administration and Monitoring Console and Web 
Data Verification Station. 

To install IIS, do the following: 

1. In My Computer local menu, choose Manage. 
2. In the Server Manager console, that opens click Add Roles and from the roles list select Web Server (IIS). 

 

http://support.microsoft.com/kb/318785
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3. During installation, Windows may ask for the source distribution files, so you need to have Windows installation CD. 
4. Enable installation of the following IIS internal components: 

-> Web Management Tools 
-> IIS Management Console  
-> IIS 6 Management Compatibility 

               -> IIS 6 Metabase and IIS 6 configuration compatibility 
               -> IIS 6 Scripting Tools 
        -> World Wide Web Services 
               -> Application Development Features 
                       -> ASP.NET 
                       -> ISAPI Extensions 
               -> Common HTTP Features 
                       -> Static Content 
               -> Security 
                       -> Windows Authentication 

 -> Basic Authentication 
Components associated with these internal components will also be enabled. Here is the list of components installed for 
IIS 7.5: 
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Other IIS components can be installed according to user preferences, e.g., perform a complete installation of IIS. 

Preparing the Application Server for installation on Windows 2003 
This instruction can also be used when installing the Application Server on Windows XP. 
The following components must be installed on your computer before you can install the Application Server: 

• Net Framework 3.5 SP1 
This component, together with a number of other components, can be installed by selecting Install External Components in the 
Autorun menu. 

• IIS (Internet Information Services) 
To install IIS, select Add or Remove ProgramsAdd/Remove Windows Components. 
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During installation, Windows may require files from the setup disk, therefore be sure to have the Windows disk ready at hand. 
If any of the components is missing on your computer, the setup program will display a warning message and the installation of 
the Application Server will stop. 
Once the installation is complete, open the Administrator Console and make sure that the IIS service is running. 
Important! In Windows 2003 ASP.NET is disabled by default for security reasons. This will cause “Error 404 File not found” 
when you attempt to start the Monitoring Station. To solve the problem, allow the ASP.NET v2.0 service extension in the IIS 
Manager: 
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This service extension will appear in the list only after you install NET Framework 3.5 SP1. 
If ASP.net was installed before installation of IIS, registration of ASP.net must be performed:  
%systemdrive%\Windows\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe –i 
If your computer runs Windows 2003 (64-bit) or Windows XP (64 bit), do the following: 

1. Execute the following command from the command line: cscript % system-

drive% \ Inetpub\ AdminScripts\ adsutil .vbs set W3SVC/ AppPools/ Enable32BitAppOnWin64 true 
This command switches the default pool to 32-bit mode, thus the default pool and the pools of the Administration and 
Monitoring Console run in the same mode which is required for registration of ASP.net. 
For this command to take effect, access to the Network Service account must be granted explicitly. To grand access to 
the Network Service account, execute the following command: aspnet_regiis -ga "NT Authority\ Netw ork Service". 

2. Make sure that the World Wide Web Publishing service is running in 32-bit mode: 
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3. Execute the following command from the command line: 

% systemdrive% \ Window s\ Microsoft.NET\ Framework\ v2.0 .50727\ aspnet_regiis.exe –i 

4. The list of IIS service extensions (see below) will now include an entry for the 32-bit version of ASP.Net. Change its 
status to allowed: 

 

Installing the servers 
Once you have made the preparations for installing the Application Server, install the servers. 
By default, all servers are installed on the same computer. However, you can install them on different computers by disabling the 
redundant servers in the setup program. 
To install the ABBYY FlexiCapture servers: 

1. In the Autorun menu, select Distributed Installation. Next, select Install Servers to start the installation. 

2. Select a setup language. The setup program will compare the locale of your system and the selected language. If the lan-
guages are incompatible, a warning message is displayed. 

3. Next, the setup program checks the version of your operating system and the availability of the administrative permis-
sions. If the version of the operating system is not supported by the program or you do not have the administrative per-
missions, a warning message is displayed and the setup program is terminated. 
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4. If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement 
carefully and if you agree with the terms of the agreement, select the corresponding option and click Next. 

5. A dialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation. 

6. Next, select the servers to install. You can also specify a destination folder. By default, the program is installed to: 
%systemdrive%\Program Files (x86)\ABBYY FlexiCapture 10 Servers ((%systemdrive%\Program Files\ABBYY 
FlexiCapture 10 Servers if 32-bit OS version is used).  

• Processing Server – the server that controls the operation of the Processing Stations 

• Protection Server – the server that stores and manages licenses. When you install servers on different worksta-
tions, you must specify the address of this server or the Protection Server in the format server, without \\ or http:// 

• Application Server – the server that controls the operation of the other components. When you install servers on 
different workstations, you must specify the address of this server or the Application Server in the format server, 
without \\ or http:// 

• Web Stations – the Application Server components which allow operators to connect to the server and work using 
a web-browser. 

• Web Stations Authentication Module – the Application Server component which allows operators of web stations 
to register with the system and create requests for access rights to the web station. Provides operators of web sta-
tions with a single entry point into the system. Installing this component is available on IIS 7 or later 

• Stations Installer – selecting this option will copy the stations’ setup files onto the Application Server so that you 
can then deploy them from the server. SMS and Active Directory deployment are supported. Once you select this 
component, you can specify the destination folder where to copy the setup files. 

7. Next the setup program will check if Net Framework 3.5 SP1 and IIS are installed on your computer. If any of the com-
ponents is missing on your computer, the setup program will display a warning message. 

8. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a 
message saying that the application has been successfully installed. 

9. Once the installation is complete, FlexiCapture 10 License Manager will be launched automatically so that you can ac-
tivate your serial number. See Managing Your Licenses section for details. The Monitoring Station will also be 
launched, where you can set up the installed Application Server. 

10. After the installation is complete, in the IIS Manager console (Start -> Administrative Tools -> Internet Information Ser-
vices (IIS) Manager), check if IIS server and Default Web Site are running: 

 
If the server is stopped, in the Manage Server menu, choose Start. Similarly, check whether Default Web Site is running.  

IMPORTANT! The Application Server should be available on the Internet if you wish to use the remote stations over the Inter-
net. 
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External components required for the correct operation of the system 
• Ikey  driver 

This component is required if you are going to use a USB key license. On Windows 2008 R2 or another 64-bit operating 
system, it is necessary to install a 64-bit version of iKey driver manually. It can be installed by selecting Install External 
Components in the Autorun menu.   

Note: On 32-bit operating systems, no additional steps are required to install the iKey driver. Installation will be done 
automatically.  

• Microsoft Core XML Services (MSXML6) 

This component is required for the operation of the Application Server. It is installed automatically.  

• Crystal Reports 
This component is used by the Administration and Monitoring Console to generate reports. Crystal Reports can be in-
stalled on the same computer where the Application Server is installed. Without this component, you will not be able to 
generate reports. However, all other Application Server management functionality will be available. ABBYY FlexiCap-
ture 10 supports Crystal Reports 2008 and 2010. Crystal Reports is not installed automatically and should be installed 
manually. A 32-bit version of Crystal Reports 2008 can be installed by selecting Install External Components in the Au-
torun menu.  

Note: Whether to install a 32- or 64-bit version of Crystal Reports is determined by the mode, in which the pool of the 
Administration and Monitoring Console is running in IIS (FlexiCapture 10 Monitoring). For details, see «System com-
ponents in IIS and their configuration». By default the pool of Administration and Monitoring Console runs in 32-bit 
mode. However, it can be transferred to 64-bit mode, which allows you to use Crystal Reports 64-bit. For details, see 
«Switching system components to 64-bit mode». 

If the bit does not match the following error message will appear: 

A runtime error occurred:  
CrystalReports loading failed  
Details:  
Description Exception has been thrown by the target of an invocation.  
Source mscorlib  
Stack trace at System.RuntimeTypeHandle.CreateInstance(RuntimeType type, Boolean publicOnly, Boolean noCheck, 
Boolean& canBeCached, RuntimeMethodHandle& ctor, Boolean& bNeedSecurityCheck) at Sys-
tem.RuntimeType.CreateInstanceSlow(Boolean publicOnly, Boolean fillCache) at Sys-
tem.RuntimeType.CreateInstanceImpl(Boolean publicOnly, Boolean skipVisibilityChecks, Boolean fillCache) at Sys-
tem.Activator.CreateInstance(Type type, Boolean nonPublic) at System.RuntimeType.CreateInstanceImpl(BindingFlags 
bindingAttr, Binder binder, Object[] args, CultureInfo culture, Object[] activationAttributes) at Sys-
tem.Activator.CreateInstance(Type type, BindingFlags bindingAttr, Binder binder, Object[] args, CultureInfo culture, 
Object[] activationAttributes) at System.Reflection.Assembly.CreateInstance(String typeName, Boolean ignoreCase, 
BindingFlags bindingAttr, Binder binder, Object[] args, CultureInfo culture, Object[] activationAttributes) at ReportMa-
nager.loadCrystalReports() 

System components in IIS and their configuration 

Application pools 
During the installation of the Application Server, the installer automatically adds two IIS application pools associated with 

ABBYY FlexiCapture 10. Application pools enable interaction with workflows bound to one or more applications and sharing 

data between them. 

FlexiCapture 10 Monitoring – enables operation of the Administration and Monitoring Console 

FlexiCapture 10 Web Services – enables operation of the Application Server. 

Both pools are configured automatically during the installation of ABBYY FlexiCapture. Pool settings critical for correct opera-

tion of the Application Server, are listed below: 

- .Net Framework Version = v2.0 

- Managed Pipeline Mode = Integrated 

- Identity = NetworkService 
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Besides, Web Data Verification Station, Web Scanning Station and Web Capture Station will be added to DefaultAppPool (de-

fault IIS pool). 

ABBYY FlexiCapture 10 application pools work in 32-bit mode. In IIS Manager Console, you can check if 32-bit mode is 

enabled. For this, do the following:  

1. Run the IIS Manager Console from the menu: Start -> Administrative Tools -> Internet Information Services (IIS) 

Manager.  

 

2. Choose Application Pools. 
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3. Choose a desired pool from the list. In the Actions menu, select Advanced Settings… 

 

The value of Enable 32-Bit Application must be True. It means that the pool works in 32-bit mode.  

Besides, the installer adds the following applications to Default Web Site (the set of applications depends on the configuration 

selected during the installation): 

Default Web Site\FlexiCapture10 – the Administration and Monitoring Console 

Default Web Site\FlexiCapture10\Server – the Application Server, including Default Web 

Site\FlexiCapture10\Server\WebServices.dll (a web service of the Application Server which supports both Windows and Basic 

authentication). 

Default Web Site\DataVerification – Web Data Verification Station (will be added if the Web Stations component is selected 

during the installation of ABBYY FlexiCapture 10 Servers) 

Default Web Site\Scanning – Web Scanning Station (will be added if the Web Stations component is selected during the installa-

tion of ABBYY FlexiCapture 10 Servers) 

Default Web Site\Capture – Web Capture Station (will be added if the Web Stations component is selected during the installa-

tion of ABBYY FlexiCapture 10 Servers) 

Authentication settings for FlexiCapture 10 Web Applications 
To control access to the applications via http protocol, it is necessary to configure authentication settings (login/password-based 

connection verification of a user’s identity). For this, choose a desired application and then choose the Authentication item.  
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Then select a required authentication method from the list and enable it. 

 
To access ABBYY FlexiCapture 10 applications, the 3 types of authentication are used: 
Windows authentication – a user tries to login to the server using the same credential under which the user browser runs. 
Basic authentication – login and password are transmitted over the network in clear text. 
Anonymous authentication – the server does not require the client to transfer the credential. 
Authentication settings are configured by the installer automatically, however if you later change the settings manually, some 

parts of the system will become unavailable. In this case, modify them the following way:  

Default Web Site\FlexiCapture10 (Administration and Monitoring Console) - only Windows authentication: 
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Default Web Site\FlexiCapture10\Server (Application Server) - both Windows authentication and Basic authentication are 

enabled: 

 

Default Web Site\DataVerification (Web Data Verification Station) - only Anonymous authentication is enabled: 
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Default Web Site\Scanning (Web Scanning Station) - only Anonymous authentication is enabled. 

Default Web Site\Capture (Web Capture Station) - only Anonymous authentication is enabled. 

Web Clients Authentication Module 
A new functionality, Web Clients Authentication Module, has been added in the 3rd release of ABBYY FlexiCapture 10. 
By default, installation of this module is disabled. It can be enabled at the step of selecting installation components. If you make 
an upgrade from the previous releases of FlexiCapture 10, this component is not installed either, however it can be installed after 
upgrade by using the menu StartControl PanelPrograms and FeaturesModify. 
Web Clients Authentication Module can be installed on the computer with the Application Server. For its installation, IIS 7 or 
later is required, besides Web Stations component of the server installation must be installed (or selected for installation). 
Web Clients Authentication Module adds to IIS a new authentication type - ABBYY FlexiCapture Authentication which is to be 
used by operators who work at the Web Capture, Web Scanning and Web Data Verification Stations. Besides, a web application 
Login is installed, which allows operators of web stations to log into the system, register within the system and request the neces-
sary access rights from the administrator. 
In this module is installed, the following changes occur in IIS: 

1. A new Default Web Site\Login application is added to Default Web Site. In the settings of this application, only Ano-
nymous authentication is enabled. 

2. This application is bound to the FlexiCaputre 10 Monitoring pool of the Administration and Monitoring Console. 
3. A copy of the Default Web Site\FlexiCapture10\Server\WebServicesExternal.dll web service which supports only 

ABBYY FlexiCapture Authentication is added to the Application Server. 
4. Web Capture Station, Web Scanning Station and Web Data Verification Station are switched to the operating mode 

which uses ABBYY FlexiCapture Authentication. For this, in web.config application files, the value of the «UseCus-
tomAuthentication» key is changed to True by the installer. (Without installing the Web Clients Authentication Mod-
ule, the key value is False. In this case, the stations work without using ABBYY FlexiCapture Authentication).  
For these applications, only Anonymous authentication remains enabled in authentication settings of IIS. 

Handler Mappings 
In IIS services, handlers process requests to sites and applications. The handlers are mapped to resources on a web server and 

create responses to those requests. Like the modules, the handlers are implemented using native or managed components, such a 

dynamic DLL or managed code. 

During the installation of ABBYY FlexiCapture 10 Application Server, mappings required for correct processing requests from 

the Application Server are added to IIS by the installer. These mappings can be view in the IIS Manager console. For this, select 

the Handler Mappings item for Default Web Site\FlexiCapture10\Server (the Application Server). 
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For correct operation of the Application Server, the installer creates a mapping «ABBYY FlexiCapture WebService» with the 

following parameters: 

Request path = «*.dll» 

Executable = «C:\inetpub\wwwroot\FlexiCapture10\Server\WebServicesIsapi.dll» 

 

Access = «Script» («Scripts and Executable» on IIS 6) 
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Note: It may happen that a third-party application is installed on the same computer as the Application Server, and it can intercept 

requests of ABBYY FlexiCapture 10. In this case, the following error message will occur when starting the Administration and 

Monitoring console: 

A runtime error occurred:  

Cannot get file storage path  

Details:  

Description Client found response content type of 'text/html; charset=utf-8', but expected 'text/xml'. The request failed with the 

error message: -- Server Error in Application "DEFAULT WEB SITE/FLEXICAPTURE10/SERVER"Internet Information Ser-

vices 7.5 

Error Summary 

HTTP Error 500.0 - Internal Server Error 

There is a problem with the resource you are looking for, so it cannot be displayed. Detailed Error InformationModule IsapiMo-

dule  

Notification ExecuteRequestHandler  

Handler Custom Handler  

Error Code 0x8007007f  

Requested URL http://127.0.0.1:80/FlexiCapture10/Server/WebServices.dll?Handler=Default  

Physical Path C:\inetpub\wwwroot\FlexiCapture10\Server\WebServices.dll  

Logon Method Negotiate  

Logon User WORKGROUP\WIN-COSLCUOARGA$  

In this case, a handler which intercepts the request to the Application Server is called Custom Handler. 

ISAPI and CGI Restrictions 
The installer of FlexiCapture10 servers creates an allowance for the ISAPI-extension of the Application Server.  
To view the list of allowed ISAPI-extensions, at the upper level of the IIS Manager console (the level of IIS server) select ISAPI 
and CGI Restrictions. 
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«FlexiCapture 10 Web Services» extension (path «C:\inetpub\wwwroot\FlexiCapture10\Server\WebServicesIsapi.dll») must be 
allowed. 

 

Checking the operation of IIS 
To check the operation of IIS, start IIS by selecting StartControl PanelAdministrative ToolsInternet Information Ser-
vices. If a problem occurs when starting IIS, the following message will be displayed: “Unexpected error 0x8ffe2740 occurred” 
for v. 5.1 (Windows XP) or “The process cannot access the file because it is being used by another process” for v. 6.0 (Windows 
2003), v. 7.0 (Windows 2008) and v. 7.5 (Windows 2008 R2). 

This error message means that port 80 is in use. To find out which application is using the port, do the following: 

1. In the command line (StartRun), type 
netstat -anop TCP|find ":80" 
The list of connections to port 80 will be displayed and the ID of the corresponding process in the following format: 
TCP   0.0.0.0:80            0.0.0.0:0             LISTENING      1264 

2. Type 
tasklist /SVC /FI "PID eq 1264" 
replacing 1264 with the ID of the process obtained at step 1. The result will be displayed in the following format: 
Image Name         PID    Services 
================================ 
Virus.exe          1264   KillMePlz 

3. End the process that uses the port. 
Important! Do not switch IIS over to another port, as you will not be able to start the Application Server in this case. 

Working over https 
To ensure safety, you can use https protocol. For this, you need to enable SSL support in IIS settings. 
To work with IIS over HTTPS protocol, you need to obtain a certificate for the server and connect it. 
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Managing certificates 
To open the Certificates control panel, do the following: 

1. Run Microsoft Management Console. For this, open Start->Run menu, type “mmc” and press Enter. 

 
2. In the console that opens, choose File->Add/Remove Snap-in. in the window that opens, click Add and from the list of 

available modules choose Certificates. Click Add. 

 
3. In the window that opens, choose “Computer account” and click Next. In the next window, choose Local Computer and 

click Finish. 
4. Add the certificate to the Personal folder. On Windows XP, you can obtain a certificate in the following ways:  

• Import an existing certificate from file. For this, choose Action -> All Tasks -> Import and specify the path to the 
certificate file. 

• Request a certificate from the domain Certificate Authority (provided that Certificate Authority is a part of do-
main). For this, choose the menu item: Action -> All Tasks ->Request new certificate, in the certificate type, speci-
fy “Computer”, then specify the name of the certificate. 

• You can also obtain a certificate from an online Certificate Authority (e.g. a free certificate can be obtained at 
www.cacert.org). 

Connecting certificate in IIS on Windows XP 
1. On the IIS Manager panel, open the Default Web Site properties dialog box. 
2. In the Secure Communications section of the Security tab click “Server Certificate…” 

http://www.cacert.org/
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3. In the window that opens, choose a certificate to be used by the server. 

 
 
After you choose a certificate, you can enable the option which allows only https connections to the Internet for a selected site or 
for Default Web Site. For this: 

1. Open the Security tab of the site properties. 
2. In the Secure Communications section click Edit. 
3. In the window that opens select the option “Require secure channel (SSL)”. 
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Connecting certificate in IIS on Windows 7 
In IIS settings, connect HTTPS protocol for Default Web Site. For this: 

1. Run IIS Manager Console from the Control Panel. 
2. Choose Default Web Site and on the Actions panel, click the Bindings link. 
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3. In the dialog box that opens click Add and select “https” protocol from the “Type” drop-down list. 
4. From the “SSL Certificate” drop-down list, select a desired certificate and click Ok. 

 
5. If you want the site to be available via https only, then choose it in the tree of sites, open SSL Settings and select the op-

tion «Require SSL». 
Note: Verification of client certificates is not performed, so when configuring SSL, set the value of the «Client certificates» op-
tion to Ignored. 

Switching system components to 64-bit mode 
Important! This configuration is not recommended (e.g., pool of the Application Server (FlexiCapture 10 Web Services) does not 

work in 64-bit mode). In particular, when using Oracle as a database server, the Oracle client through which a connection to the 

database is performed must work in the same bit mode as both the pool of Administration and Monitoring console (FlexiCapture 

10 Monitoring) and the pool of Application Server. If you switch the pool of Administration and Monitoring console to 64-bit 

mode, it will work in a different mode than the Application Server pool (which works in 32-bit mode). A possible solution is to 

install two identically configured Oracle clients one of which works in 32 bit mode and the other in 64 bit mode. 

You may need to switch the pool of Administration and Monitoring console to 64-bit mode if you are using Crystal Reports х64 

(a tool for generating reports), так как их разрядность должна совпадать, а использование Crystal Reports х32 невозможно. 

By default, the pool of the Administration and Monitoring console works in 32-bit mode. To switch it to 64-bit mode, do the fol-

lowing: 

1. Open IIS Manager Console: Start -> Administrative Tools -> Internet Information Services (IIS) Manager.   
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2. Choose Application pools. 

 

3. From the list of pools, choose FlexiCapture 10 Monitoring and in the Actions menu, select Advanced Settings… 
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The value of Enable 32-Bit Application parameter must be False. It means that the Administration and Monitoring console 

works in 64-bit mode.  

In addition, check if using of 64-bit version of ASP.net is allowed in IIS settings. For this, open the IIS Manager console and 

choose the IIS server. From the menu on the right, select ISAPI and CGI Restrictions.   

 

Allow using ASP.NET v2.0.50727 for Framework 64-bit (path C:\Windows\ Microsoft.NET\ Framework64\ v2.0.50727\ asp-

net_isapi.dll) 
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Database server  
SQL 

• For the Application Server to work, MS SQL Server version 2005 SP2, 2008 SP1 or 2008 R2 is required. On the server, the 

"Mixed Mode" ("SQL server and Windows authentication") must be enabled for authentication. The installation CD contains MS 

SQL Server 2005 Express. It can be used for demonstrative purposes and small projects. This version has a limitation on the data-

base size of 4GB. If you already have an installed copy of MS SQL Server 2005 or 2008, you can use it. 

Oracle 

• Instead of SQL Server, the Oracle Server 10g or 11g can be used as a database server. For this, a 32bit client for the Oracle data-

base must be installed.  

Important! By default, an Oracle database allows a maximum of 40 processes and 49 sessions. When these limits are reached, 
the following error message occurs: “ORA-12516: TNS:listener could not find available handler with matching protocol stack”. 
If required, increase the default values by using a script similar to the following: 
connect sys/<Login> as sysdba; 
alter system set sessions=<SessionCount> scope=spfile; 
alter system set processes=<ProcessCount> scope=spfile; 
shutdown immediate; 
startup; 

Interaction of the system components 
The following figure displays the system component interaction for distributed installation: 
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So the following ports have to be enabled: 

• Application Server— 80 if HTTP is used or 443 if HTTPS is used 

• Processing Server — 10020 

• Licensing Server — 10040 

• Processing Station — 10021 

Note. It is recommended that you should disable the iPv6 protocol in the adapter properties, otherwise addresses of the hosts are 
not displayed correctly in the Administration and Monitoring Console. 

Installing the stations 
The following installation methods are available to install the stations: 

• manually (interactive installation) 

• from the command line 

• using Active Directory 

• using Microsoft Systems Management Server (SMS) 
The automated installation methods give you speed and flexibility when installing ABBYY FlexiCapture 10 on a local area net-
work, as you do not have to install the program manually on each individual workstation. 

Manual (interactive) installation 
To install ABBYY FlexiCapture stations: 

1. In the Autorun menu, select Distributed Installation. 

2. Select Install Workstations to start the installation. 

3. Select a setup language. The setup program will compare the locale of your system and the selected language. If the lan-
guages are incompatible, a warning message is displayed. 
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4. Next, the setup program checks the version of your operating system and the availability of the administrative permis-
sions. If the version of the operating system is not supported by the program or you do not have the administrative per-
missions, a warning message is displayed and the setup program is terminated.  

5. If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement 
carefully and if you agree with the terms of the agreement, select the corresponding option and click Next. 

6. A dialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation. 

7. Next, select a destination folder. By default, the program is installed to: %systemdrive%\Program Files\ABBYY 
FlexiCapture 10 Stations 

8. Select the stations to install:  

• Scanning Station scans documents and sends them to the server for further processing 

• Processing Station automatically recognizes, imports, and exports documents; controlled by the Processing Server 

• Project Setup Station is used to set up projects on the server and local projects 

• Data Verification Station is used to verify uncertainly recognized characters 

• Verification Station is used to verify data, correct document assembly errors, handle exceptions 

• FlexiCapture Studio is a tool for creating FlexiLayouts 

• FormDesigner is a tool for creating forms 
Just like the servers, the stations can be installed on the same or on different computers. 

9. If a Processing Station is selected, a dialog box will appear where you must select the account under which the 
Processing Station service will run. By default, the service runs under the user NETWORK SERVICE. If you plan to 
import/export data on this station from/to a storage location with restricted user rights, or if this station is not in the do-
main, you can specify the user that has the appropriate rights. In this case, the Processing Station service will run under 
this user. 

10. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a 
message saying that the application has been successfully installed. 

11. If FlexiLayoutStudio, FormDesigner, Verification or Project Setup Station is installed, provide the address of the 
Protection Server in the next dialog box. The Protection Server is installed via server installation. The address should not 
contain slashes, for example: MainServer 

Command line installation 
In the default configuration, all recognition languages are installed on the local computer and the interface language is selected 
automatically based on the regional settings of the computer on which the program is installed. All stations are installed, and the 
network name of the computer from which the setup program is run is used as the Protection Server (in the case of standalone 
installation, “localhost” is specified). The default user becomes the user of the Processing Station. 
Run the setup.exe file located in the administrative installation folder using the command line options described below. 

Advertise installation 
For advertise installation, type 
Setup.exe /j 
The program icon will appear in the Start menu of the workstation. Clicking this icon automatically installs the program in de-
fault configuration. 

Silent installation 
In the case of silent installation, no setup dialog boxes are displayed and the program is installed in default configuration. 
Setup.exe /qn 
Change “/qn” to “/qb” if you want an installation progress bar to be displayed. 
No other dialog boxes will be displayed. 
Additional command line options 
/L<language code> disables auto selection of the interface language and installs the program with the interface language you spe-
cified. 
The following language code values are available: 
1033 English 
1049 Russian 
1031 German 
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1036 French 
2052 Chinese simplified 
1040 Italian 
1034 Spanish 
2074 Serbian 
1029 Czech 
1038 Hungarian 
1045 Polish 
1046 Portuguese (Brazilian) 
1042 Korean 
/V <command line> passes the specified command line directly to msiexec.exe. The <command line> string can be replaced with 
the following commands: 
INSTALLDIR="<destination>" – the path to the folder where ABBYY FlexiCapture 10 is to be installed. 
STATIONS=0,1,2,3,4,5,6 – the list of stations to install. 
The numbers 0 to 6 correspond to the following stations: 
0 – Scanning Station 
1 – Processing Station 
2 – Verification Station 
3 – Data Verification Station 
4 – Project Setup Station 
5 - FlexiLayout Studio 
6 - FormDesigner 
ACCOUNTTYPE=Custom, LOGIN=user name, PASSWORD=password 
You can specify an account under which to run the Processing Station service. 
Example: 
Setup.exe /qn /L1049 /v INSTALLDIR="D:\FC10" STATIONS=1,4 ACCOUNTTYPE=Custom 
LOGIN=Domain\UserLogin PASSWORD=PSWD 
As a result, the Processing and Project Setup Stations will be installed into D:\FC10, and Russian will be used the language of the 
interface. The Processing Station service will run under the account Domain\UserLogin and the password will be PSWD. 
PROTECTIONSERVER=ServerName – the name of the protection server. 
Removing ABBYY FlexiCapture in silent mode 
msiexec /x {FC10000C-0001-0000-0000-074957833700} 

Using Active Directory 
Microsoft© Windows© 2000 Server and later include an integrated directory service, Active Directory, which in turn includes 
Group Policy. The Software Installation snap–in, which is part of Group Policy, allows you to install a software application on 
several workstations simultaneously. 
Three major installation methods are implemented in Active Directory: Publish to User, Assign to User, and Assign to Com-
puter. ABBYY FlexiCapture 10 can be installed using the Assign to Computer method. ABBYY FlexiCapture 10 will be in-
stalled on the specified workstation after the workstation is restarted.  
The Publish to User and Assign to User methods are not supported. 
When deploying ABBYY FlexiCapture 10 using Active Directory®, the account of the computers in  the Domain Computers 
domain must have read right to  the administrative installation folder. 

Example: Deploying ABBYY FlexiCapture 10 using Active Directory 
The program is installed on one domain computer or on a group of domain computers: 

1. During Server Installation, install the Station Installer. If you did not install the Station Installer when installing the Ap-
plication Server, install the Station Installer by selecting Control PanelAdd or Remove ProgramsChange. 

2. Select StartControl PanelAdministrative and then select the Active Directory Users and Computers item. 
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3. Right–click the site, domain, or another organized unit that contains the computer or group of computers onto which 

ABBYY FlexiCapture 10 is to be installed. 

 
4. On the shortcut menu, select Properties and click the Group Policy tab: 
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5. Click New, enter a descriptive name, and click OK. 

6. Right-click the Group Policy Object you have created and select Edit... 

7. In the Group Policy window, right-click Computer Configuration/Software Settings/Software Installation. 

8. On the shortcut menu, select New/Package. 
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9. Provide the path to the file ABBYY FlexiCapture 10 Stations.msi, which is located in the administrative installation 
folder on the server. 

10. Select the Advanced deployment method. 

 
11. In the dialog box that opens, click the Modifications tab and then click the Add button. 

 
 

12. Select the interface language to be used in ABBYY FlexiCapture 10. The language files are located in the administrative 
installation folder on the server. 
The list of available files and their corresponding languages: 
1033.mst English 
1049.mst Russian 

Using SMS 
Microsoft Systems Management Server automates software deployment and eliminates the need to go directly to the locations 
where the software is to be installed (computers, groups, or servers). 
SMS deployment includes the following three stages: 

1. Creating an ABBYY FlexiCapture 10 deployment package. 
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2. Creating a deployment script (contains installation parameters: names of computers, time of installation, conditions for 
installation, etc.). 

3. Deployment of the program on the workstations by SMS based on the script settings. 

Example: Deploying ABBYY FlexiCapture 10 using Microsoft SMS 
1. When installing the Application Server, create an installation package for ABBYY FlexiCapture 10 stations. 

2. In the SMS Administrator console, select the Packages node. 

3. In the Action menu, select New/Package. 

 
4. In the Package Properties dialog box, fill out the required fields. 
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5. Click the Data Source tab. 

6. Make sure that This package contains source files is cleared and click OK. 

7. Expand the node of the newly created package and select Programs. 

8. In the Action menu, select New/Program. 
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9. In the Program Properties dialog box, click the General tab and on this tab: 

• In the Name field, type a descriptive name of the program  

• In the Command Line field, type setup.exe /q 

• In the Start in field, provide the network path to the ABBYY FlexiCapture administrative installation folder (e.g. 
\\MyFileServer\Programs Distribs\ABBYY FlexiCapture 10). 

10. In the Program Properties dialog box, click the Environment tab and on this tab: 

• Clear the User input required option 

• Select the Runs with administrative rights option 

• Make sure that the Run with UNC name option is selected 
 

11. Adjust the running parameters if required and click OK. 

12. You can also use the Distribute Software Wizard. In the Action menu of the package, select Distributive Software 
and follow the instructions of the wizard. 
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Important! You cannot create Distribution Points. 

Installing Remote Stations 
Using Remote Stations allows you to connect to the Protection Server from the computers which are not part of the LAN. Remote 
Stations include the Data Verification and Scanning stations. The Verification station can be both regular and remote. 
Remote Stations can connect to the Application Server via HTTP. 
To install Remote Stations: 

1. Select Distributed Installation. 

2. Select a menu item corresponding to a station to be installed. 

3. Select a setup language. The setup program will compare the locale of your system and the selected language. If the lan-
guages are incompatible, a warning message is displayed. 

4. Next, the setup program checks the version of your operating system and the availability of the administrative permis-
sions. If the version of the operating system is not supported by the program or you do not have the administrative per-
missions, a warning message is displayed and the setup program is terminated. 

5. If all the checks are passed successfully, the end-user license agreement will be displayed. Read the license agreement 
carefully and if you agree with the terms of the agreement, select the corresponding option and click Next. 

6. A dialog box will open prompting you to enter some information about yourself. Enter the required information and con-
tinue with the installation. 

7. Next, select a destination folder. By default, the program is installed to: %systemdrive%\Program Files\ABBYY 
FlexiCapture 10 <Station>\. If there is not enough space on the selected hard disk, a window is displayed showing your 
hard disks, the available free space, and the space required by the installation. Select a disk with sufficient free space and 
continue with the installation. 

8. The program files will be copied onto your computer. Once the installation is finished, the setup program will display a 
message saying that the installation has completed successfully. 

IMPORTANT! 

1. The Application Server should be published to the Internet if you wish to use the remote stations over the Internet. 

2. The Processing Server should be started to use remote stations. 

3. Basic-authentication should be enabled in IIS in the Default Web Site\FlexiCapture10\Server folder to use such authen-
tication type when connect to the Application Server. 
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Upgrading from ABBYY FlexiCapture 9.0 
If you are installing ABBYY FlexiCapture 10 as an upgrade from version 9.0 you can use ABBYY FlexiCapture and ABBYY 
FlexiLayout projects as well as FlexiLayouts from the previous version. 

Using ABBYY FlexiCapture 9.0 Professional projects (*.fcproj)  
All ABBYY FlexiCapture 9.0 local projects (.fcproj) can be opened and used in ABBYY FlexiCapture 10. Please note the follow-
ing: 

- It is impossible to open an .fcproj-project in ABBYY FlexiCapture 9.0 once it was opened in ABBYY FlexiCapture 10, 
so you should create a copy of the project before opening it in ABBYY FlexiCapture 10 if you still need to open it in 
ABBYY FlexiCapture 9.0 

- After opening ABBYY FlexiCapture 9.0 project in ABBYY FlexiCapture 10 you may need to delete all processing re-
sults and analyze all pages once again. (You can use the project without re-recognizing but some information may be 
presented improperly, for example if the FlexiCapture 9.0 project contains format errors, they will not be presented in 
the document window the same way they are currently presented in ABBYY FlexiCapture 10). 

ABBYY FlexiCapture 9.0 network projects that were loaded on server can also be used in ABBYY FlexiCapture 10. 
Important! Both database and a project will be converted to new format and it will be impossible to use them in ABBYY Flex-
iCapture 9.0 again.  
If you need to have a Database backup or to work with both ABBYY FlexiCapture 9.0 and ABBYY FlexiCapture 10 databases at 
the same time please follow the instruction below. If it is not necessary go to the 1-st item of the instruction about upgrade. 

To create a Database backup: 

- Create a FlexiCapture 9.0 Database backup by MS SQL Server means. 

- Create a copy of FileStorage (if it is a folder on a disk) and save it in an appropriate place. 

To connect ABBYY FlexiCapture 9.0 to the backup Database: 

- Restore the Database from the backup 

- Specify path to the File Storage in the FlexiCapture 9.0 Administration and Monitoring Console. 

To create a Database copy for ABBYY FlexiCapture 10: 

- Copy a FlexiCapture 9.0 Database and rename it (for example, to FC10Database) 

- Copy a File Storage folder and rename it (for example, to FC10FileStorage) 

- After installing ABBYY FlexiCapture 10 connect to the new database (here FC10Database) and specify the path to the 
File Storage folder (here FC10FileStorage) 

- Continue working with the original FlexiCapture 9.0 database and the File Storage. 

To upgrade a network FlexiCapture 9.0 project: 

1. Finish processing of all batches in ABBYY FlexiCapture 9.0 if it is possible. 

2. Close all opened sessions via the Administration and Monitoring Console. 

3. Install ABBYY FlexiCapture 10 (both servers and stations). 

4. Make sure that FlexiCapture 9.0 database is not used by FlexiCapture 9.0. For this, do either of the following: 

- Remove ABBYY FlexiCapture 9.0 from the computer or 

- Delete the Connection String from the Windows registry: find the registry branch 
HKEY_LOCAL_MACHINE\SOFTWARE\ABBYY\FlexiCapture\9.0\WebServices and delete the “DBConnec-
tionString” parameter 

5. Upgrade the database to the necessary version in the Administration and Monitoring Console. 

6. In the Administration and Monitoring Console, open the Service -> Out-of-Processing page and check if there are any 
batches there. If yes, click the Return to processing button to send batches to further processing. 

7. In the Project Setup Station, open a project from Server. It will be converted to ABBYY FlexiCapture 10 format. 

8. Check if the project and the Document Definition settings are correct. We recommend checking state of the “Process 
whole batches” option on the Workflow tab of the Project or Batch type properties window. 

9. Continue working with the project. 
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Using ABBYY FlexiLayout Studio 9.0 projects (*.fsp) in ABBYY FlexiLayout 10 
All FlexiLayout Studio 9.0 projects can be opened in FlexiLayout Studio 10. Please note the following: 

- It is impossible to open an .fsp-project in ABBYY FlexiLayout Studio 9.0 once it was opened in ABBYY FlexiLayout 
Studio 10, so you should create a copy of the project before opening it in ABBYY FlexiLayout Studio 10 if you still 
need to open it in ABBYY FlexiLayout Studio 9.0. 

- After opening a FlexiLayout Studio 9.0 project in ABBYY FlexiLayout Studio 10 you may need to delete all processing 
results and analyze all pages once again. 

- Due to changes in FlexiLayout language some compilation errors may occur. In this case you will need to correct errors 
and re-compile FlexiLayouts. 

Using FlexiLayouts (*.afl) created in ABBYY FlexiLayout 9.0 
FlexiLayouts compiled in ABBYY FlexiLayout 9.0 can be loaded into ABBYY FlexiCapture 10. 

Sometimes due to changes in FlexiLayout language some compilation errors may occur. In this case open the *.fsp project in 
ABBYY FlexiLayout Studio 10, correct the errors and re-compile FlexiLayouts. 

Upgrading from ABBYY FlexiCapture 8.0 Professional 
If you are installing ABBYY FlexiCapture 10 as an upgrade from version 8.0 you can use ABBYY FlexiCapture and ABBYY 
FlexiLayout projects as well as FlexiLayouts from the previous version. 

Using ABBYY FlexiCapture 8.0 Professional projects (*.fcproj)  
All ABBYY FlexiCapture 8.0 Professional projects (.fcproj) can be opened and used in ABBYY FlexiCapture 10 (both Standa-
lone and Distributed). Please note the following: 

- It is impossible to open an .fcproj-project in ABBYY FlexiCapture 8.0 once it was opened in ABBYY FlexiCapture 10, 
so you should create a copy of the project before opening it in ABBYY FlexiCapture 10 if you still need to open it in 
ABBYY FlexiCapture 8.0. 

- After opening ABBYY FlexiCapture 8.0 project in ABBYY FlexiCapture 10 you may need to delete all processing re-
sults and analyze all pages once again. (You can use the project without re-recognizing but some information may be 
presented improperly, for example if the FlexiCapture 9.0 project contains format errors, they will not be presented in 
the document window the same way they are currently presented in ABBYY FlexiCapture 10). 

- All settings which were not available in ABBYY FlexiCapture 8.0 and have appeared in ABBYY FlexiCapture 10 will 
have default values. You can change settings, add batch types, set up workflow settings. To find more details about new 
possibilities of ABBYY FlexiCapture 10 please read the help file. 

Using ABBYY FlexiLayout Studio 8.0 projects (*.fsp) in ABBYY FlexiLayout 10 
All FlexiLayout Studio 8.0 projects can be opened in FlexiLayout Studio 10. Please note the following: 

- It is impossible to open an .fsp-project in ABBYY FlexiLayout Studio 8.0 once it was opened in ABBYY FlexiLayout 
Studio 10, so you should create a copy of the project before opening it in ABBYY FlexiLayout Studio 10 if you still 
need to open it in ABBYY FlexiLayout Studio 8.0. 

- After opening a FlexiLayout Studio 8.0 project in ABBYY FlexiLayout Studio 10 you may need to delete all processing 
results and analyze all pages once again. 

- Due to changes in FlexiLayout language some compilation errors may occur. In this case you will need to correct errors 
and re-compile FlexiLayouts. See Errors which may occur while converting FlexiLayouts. 

Using FlexiLayouts (*.afl) created in ABBYY FlexiLayout 8.0 
FlexiLayouts compiled in ABBYY FlexiLayout 8.0 can be loaded into ABBYY FlexiCapture 10. 

Sometimes due to changes in FlexiLayout language some compilation errors may occur. In this case open the *.fsp project in 
ABBYY FlexiLayout Studio 10, correct the errors and re-compile FlexiLayouts. See Errors which may occur while converting 
FlexiLayouts. 

Errors which may occur while converting FlexiLayouts 
Sometimes, FlexiLayouts made in ABBYY FlexiLayout Studio 8.0 cannot be compiled in ABBYY FlexiLayout Studio 10, or 
errors occur when matching a FlexiLayout.  
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If a FlexiLayout cannot be compiled, open the *.fsp project in ABBYY FlexiLayout Studio 10 and check if any of the elements 
are invalid and have error description on the Errors tab.  
It is also possible that the FlexiLayout is successfully compiled, but some errors occur during matching.  
If you have such problems after conversion, please check if it happened due to one of the errors described below. 
Please note that some elements may be found in a different way now and the logic of FlexiLayout may slightly change. Test all 
FlexiLayouts on your images before using them for recognition.  
If you need assistance please contact our Technical Support.  
Problem Comment Workaround 
A FlexiLayout will not be compiled with the following errors: 
The name of an element coincides with a 
function’s name that didn’t exist in pre-
vious versions.  
Example: in version 8.0 it was possible to 
create a text element with a name “RSA” 
and reference it using the short name: 
RSA.IsNull. This code cannot be com-
piled in ABBYY FlexiLayout Studio 10. 

If the element’s name coincides with a func-
tion’s name, it will be considered as a func-
tion’s name in the code. It’s possible to 
create an element with the name PageNumb-
er, but it is prohibited to write PageNumb-
er.IsNull (the only possible way is to write 
SearchElements.PageNumber.IsNull ); 
 

Use the full name of an element. 
Example: 
SearchElements.RSA.IsNull  
 

If the element had a name which was 
allowed in version 8.0 but prohibited in 
ABBYY FlexiLayout Studio 10, and 
there was a reference to this element 
using a short name in the AdvancedCode, 
this element will be re-named during 
conversion, but the short name in the 
AdvancedCode is not changed. So, in the 
advanced code, there will be a reference 
to the element which doesn’t exist. 

 In AdvancedCode, the element 
should be re-named manually.  

The structure like this is now prohibited: 
Let e = SearchElements.StaticText1; 
e = SearchElements.StaticText2; 

As the elements now have user-defined 
properties, the elements of the same type are 
not considered identical. 

Change the mentioned structure as 
follows: 
Hypothesis e; 
e = SearchElements.StaticText1; 
e = SearchElements.StaticText2; 

Incorrect usage of elements’ short names. 
Example: 
There are elements: SearchEle-
ments.А.A, SearchElements.А.B, Sear-
chElements.А.C. 
In previous versions, it was possible to 
use the following structure in the code of 
element C: A.B 
In ABBYY FlexiLayout Studio 10, such 
a structure cannot be compiled. А is con-
sidered  SearchElements.А.A, but this 
element has not a B field. 

A conflict may arise when short names are 
used. In version 8.0, in case of conflict, the 
high-level element was selected. In ABBYY 
FlexiLayout Studio 10, the low-level ele-
ment is selected. 
 

Use the full names of elements. 

The following errors may occur during layout matching: 
Error in element "SearchEle-
ments.StaticText", Pre-search relations 
section: D:\Tests\ForConversion\1.txt 
was not found. 

 

In ABBYY FlexiLayout Studio 10, a refer-
ence folder for relative paths to the text files 
used in the StaticText element was changed. 
In version 8.0 the relative path began from 
the batch’s folder (where the images are 
stored). In ABBYY FlexiLayout Studio 10, 
they begin from the project’s folder (the 
folder which contains the .fsp file). 

Place the mentioned text file to the 
folder indicated in the message (for 
this example, you should put the file 
“1.txt” to the following folder: 
D:\Tests\ForConversion\). You can 
also change the path to the file. 

Upgrading from ABBYY FormReader 6.5 
In ABBYY FlexiCapture 10, the structure of projects is different, so the old projects cannot be used as they are. To be able to use 
your templates and flexible descriptions created in ABBYY FormReader 6.5, please read the instructions below and take all poss-
ible issues and limitations into consideration. 
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Using ABBYY FlexiCapture Studio 1.5 projects (*.fsp) in ABBYY FlexiLayout 10 
ABBYY FlexiCapture Studio 1.5 projects can be opened in ABBYY FlexiLayout Studio 10 – no conversion is needed. Please 
note the following: 

- Once the project is opened in ABBYY FlexiLayout Studio 10, it is permanently converted into FlexiLayout Studio 10 format 
and can no longer be opened in ABBYY FlexiCapture Studio 1.5 after this point. Please make sure you create a backup copy 
of all projects for ABBYY FlexiCapture Studio 1.5 before opening them in ABBYY FlexiLayout Studio 10.  This is a safety 
measure useful in the event you still need to open the projects in ABBYY FlexiCapture Studio 1.5. 

- After opening a FlexiCapture Studio 1.5 project in ABBYY FlexiLayout Studio 10, you need to delete all processing results 
and analyze all pages once again in order to finish converting the project. 

Due to the changes in FlexiLayout language, some compilation errors may occur. In this case, you will need to correct errors and 
re-compile FlexiLayouts. Please contact our support team if you need assistance. See Errors which may occur while converting 
FlexiLayouts. 

Using FlexiLayouts (*.afl) created in ABBYY FlexiCapture Studio 1.5 
There are numerous changes in ABBYY FlexiLayout Studio 10 as compared with ABBYY FlexiCapture Studio 1.5. That is why 
we recommend opening an *.fsp project in ABBYY FlexiLayout Studio 10 first to check that there are no errors, and re-compile 
it, even though FlexiLayouts compiled in ABBYY FlexiCapture Studio 1.5 can be loaded into ABBYY FlexiCapture 10. See 
Errors which may occur while converting FlexiLayouts. 

Importing templates from ABBYY FormReader 6.5 batches (*.frm)  
All ABBYY FormReader 6.5 templates can be imported to ABBYY FlexiCapture 10. You must specify from which FormReader 
6.5 batches (*.frm) you want to import templates. 
Note: Batches created in versions earlier than 6.5 cannot be imported.  

Conversion scenario 

1. Open the ABBYY FlexiCapture 10 Project Setup Station for Distributed installation or the Administrator Station for 
Standalone installation.  

2. Create a new project (File > New Project…). 

3. Open the Document Definitions window (Project > Document Definitions…) 

4. Click Import…, then select FormReader 6.5 Batches (*.frm) from the Files of type: list and browse the FormReader 
batch from which you want to import templates. 

 
On clicking Open, the import will start.  
When the import is finished, you will see a window showing the import result with a path to the log file.  
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The log file contains information about conversion including description of warnings or errors, if there are any. 

5. The imported template(s) will appear in the list of Document Definitions. Open them and check field marking, data 
types and validation rules. Both fixed and flexible layouts with fields and their names are imported completely (except 
additional fields). All data types are imported as Custom data types of the Document Definition. Some of the validation 
rules are converted automatically; the others have to be remade manually. The information about rules’ conversion can 
be found in the Сompatibility with FormReader 6.5 validation rules table. Tips for converting rules that cannot be im-
ported automatically can be found in the Help File (“Migrating from FormReader 6.5 rules and export to FlexiCapture 
10 scripts”). 

6. Export settings are not converted, so you will need to readjust them. 

7. Test the imported Document Definition on the test batches. The images from ABBYY FormReader 6.5 batches are not 
imported, you can add them using the File > Load Images… command. 

8. Publish the converted Document Definitions. 

Document and batch structure    
If the Document Definition imported from ABBYY FormReader 6.5 contains a custom structure which is not supported in 
ABBYY FlexiCapture 10, a set of one-page Document Definitions will be imported. 

1. Document templates with predefined structure (one-page document, multi-page documents, sequence of pages) are cor-
rectly converted into the document definitions for ABBYY FlexiCapture 10 with the same structure. 

2. Custom document structure is not supported in ABBYY FlexiCapture 10. Templates with custom structure will be con-
verted into separate one-page Document Definitions. 

3. If the structure of a batch (custom sequence of documents) was defined in ABBYY FormReader 6.5, it will be ignored, 
and the batch will be considered as an arbitrary sequence of documents. 

Compatibility with FormReader 6.5 validation rules   
Support of ABBYY FormReader 6.5 validation rules in ABBYY FlexiCapture 10: 

FormReader 6.5 Equivalent in ABBYY FlexiCapture 10  Converted 
automatically 

Check against a 
database “Database Check” rule. No 

Check sums “Check Sum” rule. No 
Merge blocks “Merge Fields” rule. Yes 
Search in the list of 
suggestions 

Field properties, “Data Type” tab. List the variants of allowed values in the 
“Validation” field.  

Yes 

Replace values 
from the list 

Field properties, “Data Type” tab. “AutoCorrect options” field.  
Note. This rule will be converted if we find the value and write the result to the 
same field. If the fields are different, the rule cannot be converted, and the 
“Script” rule should be used. 

Yes 

Replace characters 
from the list 

Field properties, “Data Type” tab. “AutoCorrect options” field. 
Note. This rule will be converted if we find the value and write the result to the 
same field. If the fields are different, the rule cannot be converted, the “Script” 
rule should be used. 

Yes 

Normalize and 
check dates 

Field properties, “Data Type” tab. In the “Content” list, select “Date”; in the 
“Content Details” dialog box, select the required formats; in the “Validation” 
field, enter the required constraints. 

No 

Regular 
expressions 

Field properties, “Data Type” tab. From the “Content” list, choose “Text” or 
select the “Process value as text” option for another content type. Enter the 
required regular expression in the “Validation” field. 

Yes 

Match blocks Can be implemented via a “Script” rule (see “Field match check” sample in No 
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Help). 

If-Then rules Can be implemented via a “Script” rule (see Help for instructions on how to 
migrate). 

No 

Automation check 

Can be implemented via a “Script” rule  (see Help for instructions on how to 
migrate). 
If the logic of the rule is too complex and requires an external component to be 
used, the component should be called from within the code of a “Script” rule 
(see “Automation rule” sample in Help). 

No 

VBScript rules Can be implemented via a “Script” rule. No 

Sum in digits - sum 
in writing “Sum in digits - sum in words” rule (for Russian language). No 

Normalize prices 

Not supported; can be implemented through an external COM component 
called from a “Script” rule. 

 
Price in digits - 
price in writing 

No 

Validate passport 
series and number 

 

The information about ABBYY FlexiCapture 10 rules can be found in the “Program Settings -> Document Definitions -> Rule 
validation” article of the FlexiCapture Help File. 
For more information on the “Script” rule, see the Appendix -> Using scripts in ABBYY FlexiCapture 10 -> Scripts for customiz-
ing processing -> Types of scripts -> Script rule article. 

Template conversion issues and possible workarounds 
The validation rules and batch or document structures used in ABBYY FormReader 6.5 have no analogs in ABBYY FlexiCapture 
10 and should be re-created manually. The possible troubles with workarounds are described in the tables below.  
 
Problem Comment Workaround 
An error occurred during import: 
Import failed. 
Error: Unable to define fixed layout inside flexible. 

This bug occurred when a 
field was absent in an original 
FlexiLayout, but the compiled 
layout contained it. 

Open the *.fsp project in 
ABBYY FlexiLayout Studio 10 
first to check that there are no 
errors, and re-compile it. 

Images do not match the converted fixed Document De-
finition, although the same images matched the template 
before conversion. 

This happens due to signifi-
cant changes in technologies. 
 

Open the converted Document 
Definition in ABBYY FlexiCap-
ture 10, delete anchors, separa-
tors and static text, and re-create 
them automatically or manually. 

Some rules which can be converted (see the table) are not 
converted. 

In ABBYY FormReader 6.5, it 
was possible to create several 
rules which changed the value 
of the same field. This isn’t 
possible in FlexiCapture 10. 

Check if you really need such a 
complicated structure. Maybe, 
you can solve the problem using 
the standard ABBYY FlexiCap-
ture 10 features. If not, use the 
“Script” rule. 

In ABBYY FormReader 6.5 EE, multi-page documents 
were processed. After conversion, several one-page Doc-
ument Definitions were created instead of a multipage 
Document Definition. 

We cannot convert Custom 
structure of documents be-
cause it isn’t supported in 
ABBYY FlexiCapture 10. If 
Custom structure was used in 
FR65EE, one-page templates 
will be imported. See 
Documents and batches struc-
ture. 
The documents structure is 
described in the 
FRE6BatchDefinition.sql file. 
If this file was damaged or 
deleted, only one-page tem-
plates will be exported. 

Some complicated structures 
cannot be created in ABBYY 
FlexiCapture 10. 
Check if the 
FRE6BatchDefinition.sql file 
wasn’t damaged or deleted. 

There were annexes in the documents. The annexes are 
not enabled in ABBYY FlexiCapture 10 Document Defi-
nitions. 

In ABBYY FormReader 6.5, it 
was possible to add annexes 
using custom structure. We 
cannot import custom struc-
ture of documents. See 
Documents and batches struc-

Enable annex pages manually in 
the Document Definition 
Properties dialog box, Assem-
bly tab.  
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ture. 
The rules are converted, new rules are created but the 
order of rule execution differs from that in ABBYY For-
mReader 6.5. 

In ABBYY FlexiCapture 10 
the order of rule execution 
doesn’t depend on the user’s 
specification, it depends on the 
document structure. 

Try to re-create rules in such a 
way that they won’t depend on 
the execution order. 
If the order is very important, 
try to create a “Script” rule 
which covers all your rules.  

FlexiLayout couldn’t be compiled. There are numerous changes 
in ABBYY FlexiLayout Stu-
dio 10 compared to ABBYY 
FlexiCapture Studio 1.5.  

Open the *.fsp project in 
ABBYY FlexiLayout Studio 10, 
correct errors and re-compile it. 
If there are errors, you will see 
invalid elements with error de-
scriptions on the Errors tab. 
Possible errors and workarounds 
are described in the Errors in 
converted FlexiLayouts section. 

FlexiLayout has been compiled, but an error occurred 
during matching of this FlexiLayout. 

There are numerous changes 
in ABBYY FlexiLayout Stu-
dio 10 compared to ABBYY 
FlexiCapture Studio 1.5. 

Open the *.fsp project in 
ABBYY FlexiLayout Studio 10, 
correct the code and re-compile 
it. 
Possible errors and workarounds 
are described in the Errors in 
converted FlexiLayouts section. 

Errors which may occur while converting FlexiLayouts 
Sometimes, the converted Flexible Description cannot be compiled, or there are errors during FlexiLayout matching.  
If the Flexible Description cannot be compiled, you will see the corresponding message during templates conversion. Open the 
*.fsp project in FlexiLayout Studio 10. Some of the elements may be invalid and have error description on the Errors tab.  
It is also possible that the FlexiLayout is successfully compiled, but some errors occur during matching.  
If you have such problems after conversion, please check if it happened due to one of the errors described below. 
Please note that some elements may be found in a different way now and the logic of Flexible Description may slightly change. 
Test all FlexiLayout on the images before using them for recognition.  
If you need assistance please contact our Technical Support.  
Problem Comment Workaround 
A FlexiLayout will not be compiled with the following errors: 
The name of an element coincides with a 
function’s name that didn’t exist in pre-
vious versions.  
Example: in version 1.5 (and 8.0) it was 
possible to create a text element with a 
name “RSA” and reference it using the 
short name: RSA.IsNull. This code can-
not be compiled in ABBYY FlexiCapture 
10. 

If the element’s name coincides with a func-
tion’s name, it will be considered as a func-
tion’s name in the code. It’s possible to 
create an element with the name PageNumb-
er, but it is prohibited to write PageNumb-
er.IsNull (the only possible way is to write 
SearchElements.PageNumber.IsNull ); 
 

Use the full name of an element. 
Example: 
SearchElements.RSA.IsNull  
 

If the element had a name which was 
allowed in version 1.5 (or 8.0) but prohi-
bited in ABBYY FlexiCapture 10, and 
there was a reference to this element 
using a short name in the AdvancedCode, 
this element will be re-named during 
conversion, but the short name in the 
AdvancedCode is not changed. So, in 
advanced code, there will be a reference 
to the element which doesn’t exist. 

 In AdvancedCode, the element 
should be re-named manually.  

The structure like this is now prohibited: 
Let e = SearchElements.StaticText1; 
e = SearchElements.StaticText2; 

As the elements now have user-defined 
properties, the elements of the same type are 
not considered identical. 

Change the mentioned structure as 
follows: 
Hypothesis e; 
e = SearchElements.StaticText1; 
e = SearchElements.StaticText2; 

Incorrect usage of elements’ short names. 
Example: 
There are elements: SearchEle-

A conflict may arise when short names are 
used. In version 1.5 (and 8.0), in case of 
conflict, the high-level element was selected. 

Use the full names of elements. 
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ments.А.A, SearchElements.А.B, Sear-
chElements.А.C. 
In previous versions, it was possible to 
use the following structure in the code of 
element C: A.B 
In ABBYY FlexiCapture 10, such a 
structure cannot be compiled. А is consi-
dered  SearchElements.А.A, but this 
element hasn’t a B field. 

In ABBYY FlexiCapture 10, the low-level 
element is selected. 
 

The following errors may occur during layout matching: 
Error at position -1: Text for search not 
defined. 

In 1.5, it was allowed to search a text which 
consisted of a space only. In version 8.0 and 
10, it isn’t allowed. 

Use allowed text for searching. 
 

Error in element "SearchEle-
ments.StaticText", Pre-search relations 
section: D:\Tests\ForConversion\1.txt 
was not found. 

 

In ABBYY FlexiCapture 10, a reference 
folder for relative paths to the text files used 
in the StaticText element was changed. In 
version 1.5 (and 8.0), the relative path began 
from the batch’s folder (where the images 
are stored). In ABBYY FlexiCapture 10, 
they begin from the project’s folder (the 
folder which contains the .fsp file). 

Place the mentioned text file to the 
folder indicated in the message (for 
this example, you should put the file 
“1.txt” to the following folder: 
D:\Tests\ForConversion\). You can 
also change the path to the file. 
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Managing Your Licenses 

After you install the program, you need to activate your serial number. This section describes the use of ABBYY FlexiCapture 10 
License Manager, the license management utility supplied with ABBYY FlexiCapture 10. 

Overview 
ABBYY FlexiCapture 10 License Manager is a license management utility. It is installed on the Protection Server when the 
server are installed. 
The License Manager allows you to: 

• add new licenses 

• activate licenses 

• view license parameters 

• select and enable licenses 
Hardware licenses are activated in the same way as software licenses. 

ABBYY FlexiCapture 10 License Manager 
The main License Manager window contains the following columns: 

• Licenses – displays the list of the installed licenses 

• License parameters – displays the parameters of the selected license 
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License properties 
• General – the serial number, expiration date, licensing method, ability to use a virtual machine 

• License purpose – type of license (software or hardware), ability to provide document processing services 

• Work stations, Tools – restrictions on the number of stations in the system and the use of development tools (Flex-
iLayout Studio, FormDesigner).  

• Productivity – restrictions on the use of ABBYY FlexiCapture 10.  

• Processing – additional document processing parameters: use of FlexiLayouts, use of additional recognition lan-
guages  

• Custom components – use of components created by users  

• Import – additional import capabilities  

• Export – additional document and image export capabilities  

License statuses 
• Activated (the license had been activated) 
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• Expired (the license had expired or the page limit has been reached) 
The current (i.e. active) license has a  next to it and is highlighted in bold. 

Buttons 
• Hide License Parameters<< (License Parameters>>) – hides (shows) the detailed information about the selected 

license 

• Activate License… - launches the ABBYY FlexiCapture Activation Wizard 

• Update License… - refreshes the information about the activated license 

• Select - makes the selected license current (i.e. active) 

• Refresh – refreshes the information about the licenses available on the Protection Server 

• Close - closes the Licenses manager 

Activating a license 
ABBYY takes steps to protect its intellectual property from piracy. Software piracy is harmful both to manufacturers and to end 
users alike. Unlike legally purchased software products, pirated software is never safe and secure. 
If your end-user license agreement allows you to install and use the product only one computer, installing it on several computers 
will breach the agreement and violate the copyright laws of the Russian Federation. The activation technology restricts the num-
ber of software copies that can be used simultaneously and thus prevents the installation of one licensed copy on an unlimited 
number of computers. At the same time, one licensed copy may be installed and activated on one and the same computer any 
number of times without any restrictions. 
You will not be able to use the software product unless you activate it. 

How activation is carried out? 
The activation process takes very little time and is carried out via an activation wizard. The activation wizard helps you to send 
the data required for activation to ABBYY. These activation data are sent to ABBYY in the form of a code (Product ID) which is 
generated based on the hardware on which the product is installed. No personal data are used to generate the code and the user 
remains completely anonymous. 
The following activation methods are available: 

• via Internet - activation is carried out automatically and takes several seconds to  complete; this method requires 
an active Internet connection 

• by e-mail - an e-mail message is generated that contains the data required for activation; please do not alter the 
body or the subject of the message to ensure a prompt reply from the mail robot 

• by e-mail from another computer – an e-mail message is generated that contains the data required for activation; 
you can use this method if the Protection Server is not connected to the Internet and e-mail messages cannot be sent 
from it 

• load activation file – connect an activation file you received by e-mail in response to an activation request 
Once the activation is complete, ABBYY FlexiCapture 10 can be used on the server on which it was activated. 
You can re-install ABBYY FlexiCapture 10 as many times as you need without additional activations (provided the Protection 
Server is not re-installed). 
Note: 

1. ABBYY FlexiCapture stations automatically connect to the Protection Server and use the installed license. 

2. If you re-install the Protection Server on a different computer, you will need to re-activate your licenses (in the case of a 
license file) and change the address of the Protection Server in the Protection.ini file on the stations (see the “Connecting 
stations to the Protection Server” section for details). 

3. If there are no free activated licenses available on the Protection Server and a user tries to run the program on their 
workstation, the program will not start and a warning message will be displayed. 

4. Hardware licenses can only be activated over the Internet. 

Connecting stations to the Protection Server 
All the stations installed in the system access the Protection Server. The address of the Protection Server is stored in the Licen-
singSettings.xml file, which can be found in the installation folder.  
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The address of the server is specified in the ServerAddress tag of the MainNetworkLicenseServer attribute. 

To enable a station to access a new Protection Server, simply change the old name to the name of the computer where the Protec-
tion Server is installed. 

The same applies to the standalone version of ABBYY FlexiCapture 10. If you have one license and several operator stations, 
specify the address of the computer where the license is stored in the LicensingSettings.xml files on the workstations. 
Remote stations get licenses from the Application Server. The Processing Server connected to the Application Server must be 
running for you to get a license. 
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Setting Up FlexiCapture 10 Distributed Installation 

Setting up the system 
Once the license is installed and activated, you should set up the system: 

1. Open the Administration and Monitoring Console. Create a database.  
Note: If SQL Server is installed separately, use basic authentication. 
To use a file storage folder, select the corresponding option and provide the path to the folder. This should be a local 
folder on the Application Server. 
Important! Under Windows Vista, Windows 2008 or later versions, a database must be created with UAC disabled. If 
UAC is not disabled, a database can be created, but the Processing Server will not be able to connect to it. 
Note: If no file storage folder is used, all project files are stored in the database. For small projects, in terms of efficien-
cy and security, the two approaches are equal. Storing the project files in the databases makes backing up and restoring 
data easier but increases the size of the database, which may decrease the system performance. Therefore, storing 
project files in the database should be selected only for demonstration projects. 
Note: A file storage folder and a local file project must be excluded from the scope of anti-virus software and Window 
indexing service used for quick search. 

 
2. Upload your project to the Application Server by starting the Project Setup Station and doing the following: 

• Create a new project (FileNew Project…). Create or import at least one document definition 
(ProjectDocument Definitions). 

• Open one of the samples (available at %allusersprofile%\Application Data\ABBYY\FlexiCapture\10.0\Samples, for 
Microsoft Windows Vista and later - %public%\ABBYY\FlexiCapture\10.0\Samples). 

• Open a project you created in one of previous version of ABBYY FlexiCapture. 

• Open a new project and import a batch you created in FormReader 6.5 DE or EE. 
For the correct operation, the project should contain at least one correct and connected document definition for 
which export settings have been specified.  

Next, upload the project to the Application Server (FileUpload Project to Server…). 

3. In the Administration and Monitoring Console, select PermissionsUsers. 
Note: The user that created the database had the administrator rights and may start any stations and perform any types of 
operations. You cannot divest the creator of the database of their administrator rights. 
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4. To add a user, click the New user button. You can also import user information from Active directory. Click the Im-
port… button and find a user by name. Then use hyperlink in Login column to open page with user's information. 

5. On the user page specify account information and roles. Administrator, Monitoring Operator and Processing Server roles 
may access all projects. You must specify the projects accessible to user for the Project Settings Editor role. For the oth-
er roles you must also specify batch types. 

 
6. If required, create or import user groups and grant them the necessary access rights. Using groups saves time and makes 

user management easier. 
Note: The Administrator, Monitoring Operator, and Processing Server roles can be assigned without creating a project 
in the database. The other roles require access rights to specific projects, therefore you need to create at least one project 
before you can assign those roles. 
Important! The account of the computer on which the Processing Server runs must be added to the list of users with the 
Processing Server role. If this computer is part of a domain, the account will look like this: <Domain 
Name>\<Computer Name>$ (e.g. Fine\quad-1$). Subsequently, the Processing Server will automatically control the 
Processing Stations, their access rights, etc. 

7. Start the Processing Server Monitor (StartABBYY FlexiCapture 10 ServersProcessing Server) and set up the 
server: 

8. Select ActionsProperties and specify the address of the Application Server (e.g. http://ApplicationServer). 

9. Start the Processing Server by clicking . 

10. Add Processing Stations by selecting Stations in the tree and clicking . Add the names of the stations or locate 
them in the LAN: 
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Then select the stations in the list displayed in the main window of the Processing Server Monitor and click . 

11. If Hot Folders are to be used for image import in any of the projects, connect these folders in the node of the same name: 

 
12. If required, specify the general project processing options on the Project Setup Station (“Default” batches, 

ProjectProject Properties…, Workflow tab). If several batch types are used, specify the processing parameters for 
each batch type: select ProjectBatch Types…, select the desired type, click Edit… and then click the Workflow tab. 

Setting up Microsoft Internet Information Server (IIS) 

Checking the operation of IIS 
To check the operation of IIS, start it by selecting StartControl PanelAdministrative ToolsInternet Information Ser-
vices. If a problem occurs when starting IIS, the following message will be displayed: “Unexpected error 0x8ffe2740 occurred” 
for v. 5.1 (Windows XP) or “The process cannot access the file because it is being used by another process” for v. 6.0 (Windows 
2003), v. 7.0 (Windows 2008) and v. 7.5 (Windows 2008 R2). 

This error message means that port 80 is in use. To find out which application is using the port, do the following: 

13. In the command line (StartRun), type 
netstat -anop TCP|find ":80" 
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The list of connections to port 80 will be displayed and the ID of the corresponding process in the following format: 
TCP   0.0.0.0:80            0.0.0.0:0             LISTENING      1264 

14. Type 
tasklist /SVC /FI "PID eq 1264" 
replacing 1264 with the ID of the process obtained at step 1. The result will be displayed in the following format: 
Image Name         PID    Services 
================================ 
Virus.exe          1264   KillMePlz 

15. End the process that uses the port. 
Important! Do not switch IIS over to another port, as you will not be able to start the Application Server in this case. 

Security settings 

Major scenario 
Conditions: 

• All participants (computers and users) are in a domain. 
Features: 

• Requires minimum additional settings. 
Actions: 

1. After the system is installed, the administrator of the computer on which the Application Server is installed creates a da-
tabase and becomes the administrator of the system. The administrator may change the settings of the Application Serv-
er, upload projects to the Application Server, and grant access rights for projects. 

2. The administrator may grant administrator rights to another user, thereby delegating the administration of the system to 
that user. 

3. The administrator grants the Processing Server rights to the computer on which the Processing Server is installed (in the 
format <Domain Name>\ <Computer name>$ by default if the Processing Server operates as the Network Service; or a 
specially created domain account that is assigned to the Processing Server). If required, the administrator may create and 
set up special accounts for the Processing Stations. 

4. The administrator uploads the projects and assigns roles to the operators. 

Some of the stations are not in the domain 
Conditions: 

• Some of the stations (Scanning Stations, Verification Stations) operate remotely. 
Features: 

• NTLM pass-through authentication is used. General principle: to enable user of computer M2 (account 
M2/User[password]) to authorize on computer M1, you must duplicate this account (with the same password) on 
computer M1, i.e. create M1/User[password]. 

• The Processing Stations must be in the same domain as the Application Server. 
Actions: 

1. Do the steps of the major scenario above. 

2. On the Application Server, create accounts corresponding to the remote users. On the remote stations, create identical 
accounts (same names and passwords) and run the stations under these accounts. 

Work group 
Conditions: 

The stations and the servers are in a work group. 

Features: 

• NTLM pass-through authentication is used. General principle: to enable user of computer M2 (account 
M2/User[password]) to authorize on computer M1, you must duplicate this account (with the same password) on 
computer M1, i.e. create M1/User[password]. 
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• Basic authentication must be turned on in ISS to enable export from the Scanning Station by explicitly specifying 
the user’s login and password. 

Actions: 

1. Perform steps 1, 2 of the major scenario above. 

2. On the computer on which the application Server is installed, create a local account for the server. In the IIS settings, 
specify that the pool of FlexiCapture Web Services should run under this account. 

3. Set up the Administration and Monitoring Console: in the IIS settings, go to the ASP.NET page and specify an account 
for the FlexiCapture virtual folder (either the same account as in step 2 or a separate account). 

4. If the database is located on a computer other than the Application Server, copy the accounts from steps 2 and 3 onto the 
computer hosting the database. Additionally, duplicate the account of the administrator on the computer hosting the da-
tabase. The Administration and Monitoring Console will be run under this account in order to set up the Application 
Server (to connect to the database). 

5. Use the administrator account to run the Administration and Monitoring Console and create a new database. 

6. On the computer on which the Processing Server is installed, create an account for it. Specify this account in the 
Processing Server settings. Duplicate this account on the computer on which the Application Server is installed. 

7. In the Administration and Monitoring Console, assign the Processing Server role to the Processing Server account 
(created at step 6). 

8. If the Processing Stations run on separate computers, create accounts for them and duplicate them  on the Processing 
Server. 

9. On the computer on which the Application Server is installed, duplicate the accounts of all users that should have access 
to the system and assign roles to the users in the Administration and Monitoring Console. 

Oracle database settings 
Prior to creating a database in Oracle, do the following actions: 

1. On the computer on which the Application Server is installed, install the Oracle client for Windows 32bit (even though 
Windows x64 is installed) and Oracle DBMS for this OS. The Application Server does not work with the Oracle client 
for Windows x64. 
If Windows x64 is installed, pools for the Administration and Monitoring Console and the Application Server must 
be set to 32-bit mode. For this, do the following:  
- Execute the following command from the command line: cscript % system-

drive% \ Inetpub\ AdminScripts\ adsutil .vbs set W3SVC/ AppPools/ Enable32BitAppOnWin64 true 
This command switches the default pool to 32-bit mode, thus the default pool and the pools of the Administration and 
Monitoring Console run in the same mode which is required for registration of  ASP.net. 
For this command to take effect, access to the Network Service account must be granted explicitly. To grand access to 
the Network Service account, execute the following command: aspnet_regiis -ga "NT Authority\ Netw ork Service". 
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- Make sure that the World Wide Web Publishing service is running in 32-bit mode: 

 
2. In Oracle DBMS create a user, e.g. FCUSER, and assign the CONNECT and DBA roles to this user. One FlexiCapture 

database corresponds to one user. If several FlexiCapture databases running under Oracle DBMS are required, create a 
user for each database. 

3. Establish the connection between the client and the Oracle server using the Net Manager utility, which is installed to-
gether with the Oracle client (in the Administration configuration) and the database server. In the client utility, create a 
new Service Naming element (a local naming method), which must be connected with the Oracle database server by its 
SID. Test the connection with the database server on behalf of the user account created in step 2. Go to the next stop on-
ly if the connection test succeeds. If you cannot set up the connection, consult the Oracle documentation. 

4. When creating the database in the Administration and Monitoring Console, specify the name of the Service Naming 
element created in step 3. 

After you create the database using the Administration and Monitoring Console you should note that by default, an Oracle da-
tabase allows a maximum of 40 processes and 49 sessions. When these limits are reached, the following error message occurs: 
“ORA-12516: TNS:listener could not find available handler with matching protocol stack”. 
If required, increase the default values by using a script similar to the following: 
connect sys/<Login> as sysdba; 

alter system set sessions=<SessionCount> scope=spfile; 

alter system set processes=<ProcessCount> scope=spfile; 

shutdown immediate; 

startup; 

Recommendation for setting up FlexiCapture 10 

General recommendation 
To improve performance of ABBYY FlexiCapture, use the following recommendations: 
- Install SQL Server and FlexiCapture Application Server on different computers. The Processing and Licensing servers can be 
installed on the computer where the Application Server is installed. 
- Do not install processing stations on the computes where FlexiCapture servers or SQL Server are installed. 
- Do not store all data in SQL database. For these purposes, a File Storage should be used. This option must be selected when 
creating a database in the Administration and Monitoring Console. If a file storage was not created when creating a database, it 
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cannot be connected later while working. During work, it is also impossible to disconnect the file storage which was connected 
when creating the database.  
These recommendations are described in more detail below. 

Configuring SQL Server 

RAM 

The amount of RAM available to SQL Server should be not less than the amount recommended by Microsoft for the given edition 
of MS SQL Server (see the table of recommendations for different editions).   

The more RAM is available, the larger part of database can fit in RAM which allows faster access to database. 

However, if FlexiCapture servers are installed on the same computer, the amount of RAM available to SQL Server must be re-
stricted in SQL Server settings so that the amount of RAM was also sufficient for FlexiCapture servers including IIS (recom-
mended amount of RAM is at least 4 GB). Thus, in order to improve performance, it is recommended that SQL Server and Flex-
iCapture Servers should be installed on different computers. 

Hard disk 
It is desirable to place the database file on a fast hard drive (e.g., 15000 rpm/second). If SQL Server is installed on the same com-
puter with FlexiCapture Servers, it is desirable to use one hard disk for the %temp% folder of IIS and the File Storage and another 
disk – for SQL database. 
Database File 
The process of increasing the database file may lead to a temporary decrease in SQL Server performance, so it is recommended to 
specify in database properties in Autogrowth settings that a one-time increment of the database file must be at least 100 MB.  
Recovery model 

To improve performance of SQL Server, it is desirable to use a Simple Recovery Mode for the database. 

Rebuilding indexes 

After long work of FlexiCapture, a significant increase in the size of database can be noticed. At the same time, more than 50% of 
the space can be occupied not with data, but with the indexes in tables. In order to decrease the size of database and improve per-
formance, it is recommended that indexes of the Batch, Document, Page, EventLog and other tables should be rebuilt periodically 
(e.g., once for every million pages processed). 

Estimating the size of File Storage 

Most of the space in file storage is occupied by images being processed in the system. For each loaded file, its source image is 
stored as the original; besides black-and-white image copies and image thumbnails are created. For color images, color copies 
with quality loss are also created. 

The level of quality loss is specified in batch type properties, in the Displayed image quality field. 

http://msdn.microsoft.com/en-us/library/ms143506.aspx#Web64
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To get a relatively accurate estimate of the file storage size, you can upload 10 typical images to FlexiCapture and view the size of 
a file storage folder, in which the batch (<FileStorage>\<GUID>\project_<id>\0000-0999\<Batch Id>) is stored. 

Estimates for the file storage obtained during testing are as follows: for 1 image, 3-6 times more space in the file storage than the 
image size is needed.  

File Storage 
For the file storage, it is recommended to use a disk that is local relative to the Application Server (or a system of comparable 
performance). To achieve maximum performance, the %temp% for IIS must be located on the physical disk. If IIS runs under the 
Network Service account, a path to folder %temp% can be specified in the registry (registry branch [HKEY_USERS\S-1-5-
20\Environment], variables «TEMP» and «TMP»). 
In order to increase performance, it is recommended that a file storage folder should be excluded from the scope of anti-virus 
software, Window indexing service and other processes that require long-term access to the disk. 
Preferably use a faster hard drive (e.g., 15 000 rpm/secondу). 

Application Server 

Caching 

In order to decrease the amount of memory occupied by IIS, it is necessary to disable Output in the IIS settings. Using the cache 
does not lead to increasing performance, as the identical information is not frequently requested by FlexiCapture. 

Configuring settings of the Application Server Recycling Pool 

For FlexiCapture 10 Web Services, the Application Server pool, it is necessary to specify Recycling settings, that is to enable 
cleanup of the pool when it reaches a certain threshold of consumed memory. The threshold is determined based on the amount of 
available memory in the system: when IIS consumes maximum memory, there must remain enough memory for normal function-
ing of the operating system and other applications that can be installed on the same computer. 

It is recommended to set up a forced cleanup of the Application Server pool when the amount of occupied memory reaches 
1200000 KB. 
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Number of threads 
For the Application Server pool, the number of working processes can be specified. The optimal number of threads is two threads 
per processor core if hyper-threading technology is not used on the computer and one thread per virtual core if hyper-threading is 
used. 

 
 

Configuring FlexiCapture input and output 
Frequently, the bottleneck that limits performance of the system is the input (import) or the output (export).  

Below are the two ways to increase performance in bottlenecks of FlexiCapture: 

1. If it is assumed that a large number of Processing Stations will simultaneously import files from a hot folder or export 
files to file system, then the hot folder and/or the export target must be located on the computer with the server edition 
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of the operating system. Normally, client operating systems support a limited number of connections which may lead to 
error in import/export tasks. 

2. If a hot folder is assumed to be processed at several Processing Stations, then bandwidth to the hot folder will be divided 
between the Processing Stations which may lead to bandwidth shortage. In this case, it is recommended to use multiple 
independent hot folders. If export to files is performed, it is recommended that export target should not be on the same 
computer with the hot folders 

Using performance counters 
To monitor FlexiCapture state and search for bottlenecks, the Performance Monitor utility can be used.  

FlexiCapture counters 
FlexiCapture own counters are located in the category FlexiCapture. 

 
Values of the counters are recorded by the Processing Server, so the counters are available in the computer where this server is 
installed. 

As the Processing Server is a 32-bit application, the Performance Monitor utility must be run in 32-bit mode when used in 64-bit 
computers. For this, enter the following command in the command line (cmd.exe):  

mmc /32 perfmon.msc 

By default, recording counters by the Processing Server is disabled. To enable counters recording, perform the following actions: 

1. Start the Processing Server console. For this, on the computer where the service of the Processing Server is started, ex-
ecute the following command in the command line (cmd.exe):  
FlexiBRSvc.exe please obey 

2. Set the value of the server parameter PerformanceCounting to true. For this, execute the command: 
set PerformanceCounting=true 

3. Check the state of the PerformanceCounting parameter with the “view” command. 

4. Quit the Processing Server Manager console using the “quit” command. 

Note: To view help on the Processing Server Manager console, use the “help” command. 
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. 

 
Description of counters: 

1. ASCT Count – Application Server Communication Threads count. The number of running threads used for interaction 
with the Application Server. By default, takes values from 1 to 3. Each thread opens its session. Additional threads are 
started if, for the existing threads, latency (ASCT Latency) has reached two seconds. 

2. ASCT Latency – Application Server Communication Thread latency (ms). The latency of processing requests in the 
flows of interaction with the Processing. The downtime of queuing requests measured in milliseconds. 

The smaller this value, the better. The ideal value is zero. Values within 1000 (1 second) are the norm. 

When the counter value reaches 2 seconds and the maximum number of threads is not running one more thread is 
started. When the value reaches 30000 (30 seconds), the Processing Server switches to a critical mode: it stops taking 
new tasks and retrieving information about projects on the server until the queue is unloaded. Therefore, a long stay is 
the state > 30 seconds is generally undesirable.  

3. Primary Thread Latency – a delay in the response of the Processing Server measured in milliseconds. This index 
shows the responsiveness of the server. The increase of this index leads to “freezing” of the Processing Server Monitor. 

It is desirable that the value of this counter be minimal. This counter is the most critical. The server does not have auto-
adjusting by the value of this counter. A response delay of more the 10 seconds is highly undesirable. As a rule, an ex-
cessive growth of this counter means that a network interaction with some station is extremely slow. 

Note: With the “view” command of the Processing Server console, you can output the “Server lag time” value that cor-
responds to the maximum of the Primary Thread Latency and ASCT Latency values. 

4. Task Queue Size the size of the buffer allocated for the task. Includes all tasks displayed in the Processing Server Mon-
itor as well as some of the tasks deleted over the past 5 minutes. This counter does not matter much in terms of adminis-
tration however it can be used to monitor the correlation between the number of tasks in the Processing Server and the 
occupied memory. 

5. Cores Count – the number of cores in all started (which are in s state Started) Processing Stations of FlexiCapture. 

6. Free Cores – the number of free cores in all started (which are in s state Started) Processing Stations of FlexiCapture. 
Allows you to estimate, whether there are enough cores in FlexiCapture. 

7. Pending Tasks – the number of tasks taken into processing by the Processing Server, but not yet assigned to a 
Processing Station. Such tasks are displayed in the Processing Server Monitor in a Pending state. Note that this number 
is not the number of tasks queued in the Processing Server. 

This number may be proportional to the total number of cores in the system, but it should not be increased indefinitely. 
Admissible value: up to 2 tasks per 1 core. 
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8. Running Tasks – the total number of tasks being executed in the Processing Server at the moment. 

9. Export Count, Import Count, Recognition Count, Other Tasks Count – the number of corresponding tasks (export, 
import, recognition and others) over the past 5 minutes. 

10. Export Time, Import Time, Recognition Time, Other Tasks Time – an average execution time for the corresponding 
tasks (export, import, recognition and others) over the past 5 minutes. 

11. Modification Server Locks Count – the number of documents that are blocked for executors. The counter applies for 
the Processing Station only. 

System counters 
Sometimes, insufficient performance can be caused by the used hardware. In order to determine whether the hardware complies 
with the load and whether it has bottlenecks, system performance counters must be used. Counter used for different system com-
ponents are described below. 

RAM 

1. Memory: Available Mbytes – the amount of physical memory (RAM), in bytes, available to processes running on the 
computer. RAM consists of the physical memory and a swap file. If the RAM in the system is not enough, the paging 
mechanism is used which can lead to slowdown. 

2. Paging File: Usage – the use of paging. Data and code in the memory are divided into pages. On Intel, one page is 
equal to 4096 byte. Paging is the process of moving pages between the physical to virtual memory. Excessive move-
ment of pages from disk into memory and vice versa can lead to severe CPU load. Such a situation may look like a 
problem with the processor or disk. 

3. Memory: Committed Bytes – the committed memory. The memory reserved in the file pagefile.sys in case you need to 
dump the contents of physical memory to disk. The amount of allocated memory of the process characterized the 
amount of memory actually consumed by it. The amount of allocated memory is limited to the size of the paging file. 
The limit of the amount of allocated memory in the system (Memory: Commit Limit) is determined by how much 
memory can be allocated to processes without increasing the size of the paging file. The counter shows the total amount 
of allocated memory for all processes that is the actual amount of memory used by the system. 

4. Memory: Page Faults/sec shows how often the data are outside the working set. The working set is the physical memo-
ry (RAM) visible to a process or a program. Page faults occur when the program requests a code or data page which is 
not in the working set and must be found elsewhere. Includes soft page faults and hard page faults. A soft page fault is a 
situation when the program requests a page which is memory but out of working set. In this case, restoring data from 
disk is not required. A hard page fault is a situation when the program requests a page which is not in the physical 
memory (RAM) and must be restored from disk. Faults of this type are the best to show the presence of bottlenecks in 
the memory configuration. More than 5 faults per second show that RAM should be increased. 

5. Memory: Page Input/sec total number of pages read from disk to resolve hard page faults. Comparing with Page Faults/sec 
shows the number of soft page faults. 

6. Memory: Pages/sec – total number of pages read from disk and written to disk. This is the sum of Page Outputs/sec 
(the number of pages that had to be written to the disk to make room in RAM for other pages as a result of page fault) 
and Page Inputs/sec. The admissible average value is 0 – 20. The Pages/sec value of more than 5 per second indicates a 
bottleneck in memory configuration. Comparing with Page Faults/sec gives an idea about the number of soft page faults 
and hard page faults. 

It is also recommended to monitor the memory occupied by the following processes: 

• FlexiBrSvc.exe – the process of the Processing Server and the Processing Station. If both services are installed on 
the computer (not recommended), they can be distinguished by PID specified for the corresponding services. 

• w3wp.exe – IIS working processes. 

• sqlserv.exe – SQL Server process 

Processor 

It is recommended to exclude memory and other bottlenecks that load the processor before diagnosing a bottleneck caused by 
a process. 

Identify processes that occupy more than 80% of CPU time. If the length of the queue is more than 2 threads, the bottleneck 
in operation of the system is probably caused by this process. 

1. System: % Processor Time: _Total – time (in percentage of the whole working time) during which all processors were 
busy. For one processor, it is equal to the counter Processor: % Processor Time. For multiple processors, an average 
counter value is used. The counter measures how much time (in %) the system spends processing Idle processes and 
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subtracts this percentage from 100 %. The resulting value corresponds to the percentage of time, the processor actually 
spent working on productive threads. 

2. Processor: % Total Processor Time: - the same as System: % Processor Time, though measured for each processor. 

3. System: Processor Queue Length shows how many threads are ready in the processor queue, but not currently able to 
use the processor. Does not include a thread that is processed at the moment. Shows the current (not an average) value. 
The counter value of more than 2 indicates a bottleneck. 

Disk 

1. LogicalDisk or PhysicalDisk: % Disk Time – indicates how busy the disk is (% of working time). 

2. LogicalDisk or PhysicalDisk: Current Disk Queue Length – measures the number of the I/O transactions that are 
waiting to be handled. Contains the current value (not an average). The counter value of more than 2 for a long period of 
time indicates a bottleneck. 

3. Disk Bytes / sec: - the number of bytes transferred to the disk per second. The primary measure of the disk 
performance. 

4. Avg Disk Bytes / Transfer: - the average number of bytes transferred per read of the disk system. This is an indicator 
of the disk efficiency. The higher the value, the better. 

Network interface 
1. Network Interface: Current Bandwidth – bandwidth of the network interface. 
2. Network Interface: Bytes Total/sec – load of the network interface. If the load of the network interface is 75% or more 

of the bandwidth, than the network interface is a bottleneck. It is also worth comparing the load with the base mode in 
which the work was stable. 

3. Network Interface: Output Queue Length – network interface. If an average value of the counter is more than two, it 
means that the network interface (or the capacity of the network infrastructure) cannot cope with transferring data pro-
vided by the server. That is, server provides data at a faster rate than the network interface is able to pass. 

IIS 
1. W3SVC_W3WP: Active Threads Count: FlexiCapture 10 Web Services – the number of active threads in IIS. 
2. WebService: Current ISAPI Extension requests: Default Web site (if the FlexiCapture Application Server has not 

been transmitted to a different site by the user) – the queue of requests to be processed in IIS. If the queue is significant-
ly (2-3 times) larger than the number of active threads in IIS, then IIS is likely to be a bottleneck. You should take into 
account that the bottleneck may also be the SQL Server that executes requests for a long time causing the queue of re-
quests to increase. 

SQL Server 

SQL Server has a large number of performance counters which can help you not only estimate the server load, but also, for 
example, investigate the behavior in case of custom settings (non-optimal settings can increase the load on the server which 
can be visible with the help of the counters). 

We recommend using the main counter responsible for the server performance: 

1. SQLServer: SQL Statistics: Batch Requests/Sec counter – this counter measures the number of batch requests re-
ceived by SQL Server per second and allows you to monitor the load of processors in the server. In general, more than 
1000 batch requests per second tells of a very high load on the SQL Server and may mean that if you have not expe-
rienced a shortage of CPU resources, you may run into it in the near future. Of course, this number is relative, and the 
more powerful hardware you have, the more batch requests per second can be handled by SQL Server. 
In terms of network bottlenecks, a typical network card with a capacity of 100 Mb/s can only handle about 3000 batch 
requests per second. Under similar loads, you may need to switch to a network card with capacity of 1 Gb/s. 
You can also use the counter SQLServer: Databases: Transaction/Sec: _Total to measure the total activity of SQL 
Server. However, it measures only the activity within the transaction, not the whole activity, which can lead to errone-
ous results. 

You can also use the following counters to analyze the amount of memory consumed by the server and estimate whether the serv-
er has enough memory: 

2. SQLServer: Memory Manager — Target Server Memory (KB) shows how much memory is required for SQL 
Server. If the value of this parameter matches the value of SQLServer: Memory Manager — Total Server Memory 
(KB), it means that SQL Server has enough memory. 

3. SQLServer: Memory Manager — Total Server Memory (KB) shows how much memory SQL Server actually uses. 
If the value of this parameter matches the value of SQLServer: Memory Manager — Target Server Memory (KB), 
it means that SQL Server has enough memory. However, if the value of this counter is smaller, it means that more 
available memory is needed to optimize performance of SQL Server. 
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Logging 

Administration and Monitoring Console logs 
The event and error logs available in the Administration and Monitoring Console are the main logs that register errors that occur 
in the system in general. These logs record all errors that occur during document processing and affecting the processing and all 
events that occur during document processing. To view the logs, select MonitoringEvent Log and MonitoringError Log in 
the Administration and Monitoring Console. In the settings of the Administration and Monitoring Console, you can specify what 
type of events should be logged. Logging all events is not recommended, as it can lead to a significant increase in the size of the 
database during an intensive processing. 

Task processing logs on the Processing Servers 
The Processing Server logs the processing of the tasks. The list of the active tasks and their logs can be accessed via the 
Processing Server Monitor. To view a task log, select ActionsView Log… when selecting the task. 

OS event logs on the servers 
The server components (Application Server, Processing Server, and Processing Stations) log errors and warnings in the local 
event log of the operating system under which they are running (section: Application, sources: FlexiCapture Web Services and 
FlexiCapture Processing Server). These logs can be accessed by the administrators both locally and remotely via the standard 
Event Viewer tool of the MMC console. 
The local OS event log records not only processing errors, but also all errors in the operation of the server components not directly 
related to the processing of documents. This log will list processing errors even if the Application Server is inaccessible at the 
time of error and the error cannot be logged in the ABBYY FlexiCapture log. 
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Working with Clusters 

ABBYY FlexiCapture 10 supports clusters.  
There are two important benefits to using clusters: 

• Fault tolerance: in case of failure of one of the servers, the request will be executed by another server. 
• Distributed workloads: query processing is distributed among cluster nodes. This improves performance and  increases 

fault tolerance.  
The following ABBYY FlexiCapture 10 components can be installed on clusters: 

• Processing Server 
• Licensing Server 
• Application Server 

ABBYY FlexiCapture can work with Microsoft SQL Server installed on failover cluster. 
The Processing Server and the Licensing Server are installed on failover clusters. 
The Application Server, the Administration and Monitoring Console, and the Web Data Verification Station, which use IIS (Inter-
net Information Services), are installed on NLB (Network Load Balancing) clusters. 
Note. Failover and Network Load Balancing clusters cannot work on the same computer. 
The following figure displays the clusterization of ABBYY FlexiCapture Servers and Microsoft SQL Server: 

 
The deployment of the Processing Server and the License Server on clusters is described below in this guide. 

Setting Up the Processing Server 
Failover clusters are used for clustering the Processing Server. 
A detailed guide to failover clustering can be found on the Microsoft website.  

Deploying the Processing Server on a Failover Cluster 
In this section, you will find step-by-step instructions for setting up the server on a failover cluster. 
Note. The addresses, computer names, domain names, etc. used below are not mandatory and may be changed by the administra-
tor. 
Note. The following server configuration is intended only for local use in a local area network. 
Important! The names of servers, services, and shared folders must not contain spaces. 

http://www.microsoft.com/Windowsserver2008/en/us/failover-clustering-main.aspx
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Basic Configuration of the Failover Cluster 
In this example, the processing server is deployed on a FOC cluster (FOC.cluster2008r2.ru). The cluster uses a network with the 
address 192.168.0.0/24 and the domain cluster2008r2.ru. 
The cluster consists of two nodes: Node1 and Node2. 
Addressing in the Cluster 
The Node1 and Node2 nodes have two network interfaces: one interface belongs to the 192.168.0.0/24 network, the other may 
belong to your local area network (for example 10.0.0.0/16). The data storage only interfaces with the 192.168.0.0/24 network and 
is available only to the cluster nodes (i.e. Node1 and Node2). 
Both networks are available to the cluster FOC.cluster2008r2.ru. Cluster traffic should only be allowed in the designated network 
192.168.0.0/24 for security and workload balancing reasons. External users can access the data storage through requests to Node1 
and Node2. In order to allow cluster traffic in the 192.168.0.0/24 network, open the Failover Cluster Manager, select Cluster 
Network in the Networks group, and choose Enabled in the Cluster Use column (see the screenshot below). 

 
 
Interfaces and networks: 
Interface Network Description 
Storage 192.168.0.1/24 Centralized storage 
Node1 192.168.0.11/24 Cluster node 
Node2 192.168.0.12/24 Cluster node 
FOC 192.168.0.10/24 Cluster address 
FC10ProcServer 192.168.0.2/24 Address of the service running in the cluster 
 
Domain users 
To set up domain user accounts: 

1. Create two domain users, for example cluster2008r2\node1admin and cluster2008r2\node2admin. 
2. Give administrator rights to cluster2008r2\node1admin on Node1 and to cluster2008r2\node2admin on Node2. 
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Important! These user accounts will only be used for working with ABBYY FlexiCapture in a failover cluster to ensure correct 
usage of shared network resources.  
Important! Clustering requires the use of domain accounts. It is not possible to work under a local user account. 

Adding the ABBYY FlexiCapture 10.0 Service to the Cluster  

Install ABBYY FlexiCapture on Node1 and Node2, then create a network folder for the FlexiCapture service. 
Creating the Service  

Complete the following steps to create the service: 

1. Right-click the Services and Applications group and choose Configure a Service or Application… 

 

2. Select Generic Service from the list of services and click Next.  
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3. Choose ABBYY FlexiCapture 10.0 Processing Server from the list of available services and click Next. 

 

4. Enter the name of the service (FC10ProcServer in this example) to be used by clients and choose an address 
(192.168.0.2 in this example). Click Next. 
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5. Choose the shared drive you created for centralized storage and click Next. 

 

6. Specify the registry key: 

• HKEY_LOCAL_MACHINE\SOFTWARE\ABBYY\FlexiCapture\10.0 – for x32 systems  
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• HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ABBYY\FlexiCapture\10.0 – for x64 systems (see the 
screenshot below) 

 

7. Click Next to confirm the settings. 

 

8. To complete the creation of the service in the cluster, click Finish. 
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Creating a Shared Folder for the Processing Server Service  

1. The cluster nodes Node 1 and Node 2 need a shared folder where to store their temporary files. To create a shared folder 
for the nodes, right-click the service you created (in this case FC10ProcServer) and choose Add a Shared Folder. In 
this example, the shared drive H:\  was used (this drive was earlier created at the Storage computer). In the Location 
field, enter the name of the folder you want to share, for example H:\Cluster Temp. 
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2. To edit access permissions, select the Yes, change NTFS permissions option and click the Edit Permissions… button.  
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3. To add new users, click Add… The Select Users, Computers, Service Accounts, or Groups dialog box will open. 
Add the two previously created users from the cluster2008r2 domain and click OK.  

 

4. Give full access permissions for the folder \\FC10ProcServer\ClusterTemp to the users node1admin and node2admin. 
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5. Choose SMB as the protocol over which users will access the folder.  
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6. In the Description field, provide a description for the folder which will help you with support and maintenance in the fu-
ture. Click the Advanced… button to edit access permissions for SMB-based access. 
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7. Click Add… The Permissions for ClusterTemp window will open. Add the two previously created users from the 
cluster2008r2 domain and click OK. Give the users node1admin and node2admin full access permissions for 
\\FC10ProcServer\ClusterTemp. 
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8. If you want to publish the SMB share to a DFS namespace, select the corresponding option and click Next.  
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9. Check your settings and click Create to create the shared folder. 
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10. Click Close to complete the creation of the shared folder.  
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Setting Up the Cluster Nodes 

Next you must set up the cluster nodes Node1 and Node2. The instructions below apply to Node1. The other nodes are set up 
identically. 
Setting Up the ABBYY FlexiCapture 10.0 Processing Server Local Service  

To set up the service, complete the following steps: 
1. Enter the following command in the command line (cmd.exe): 

sc config ABBYY.ProcServer.FlexiCapture.10.0 binpath= "%systemdrive%\Program Files (x86)\ABBYY FlexiCapture 
10.0 Servers\FlexiBRSvc.exe \service -stationType:server -inifile:\\fc10procserver\ClusterTemp\ServerSettings.xml" 
This command changes the default settings for the process ABBYY.ProcServer.FlexiCapture.10.0, which is launched 
from the file "%systemdrive% \ Program Files (x86) \ ABBYY FlexiCapture 10.0 Servers \ FlexiBRSvc.exe", and 
sets the path to the following file that contains the settings for the Processing Server: \ \ fc10procserver \ ClusterTemp 
\ ServerSettings.xml. Now the file ServerSettings.xml will be stored in the shared folder and will be available to all 
nodes in the cluster. 

2. Find the service ABBYY FlexiCapture 10.0 Processing Server in the list of services (Start > Administrative Tools > 
Services). Right-click the service and choose Properties. 

 

3. Make sure that the parameters you typed in the command line are displayed in the Path to executable field. 
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4. Go to the Log On tab.  For Node1, change the user NetworkService to node1admin. For Node2, change the user Net-
workService to to node2admin. Click OK. 
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Changing the variable %appdata% 

The service ABBYY.ProcServer.FlexiCapture.10.0 creates and stores session data in the location referenced by the variable 
%appdata%. The users node1admin and node2admin must have the same folder specified for %appdata% in order for the service 
to switch between cluster nodes. 

Important! For the user cluster2008r2\node1admin, the variable %appdata% must be changed on Node1. For the user clus-
ter2008r2\node2admin, the variable %appdata% must be changed on Node2. 

You can change the variable %appdata% through the command line or directly in the registry.   

To change %appdata% through the command line: 

1. Enter the following command in the command line (cmd.exe):  
REG ADD "HKCU\Software\Microsoft\Windows\CurrentVersion\Explorer\User Shell Folders" /v AppData /t 
REG_EXPAND_SZ /d \\FC10ProcServer\ClusterTemp, where \\FC10ProcServer\ClusterTemp should be replaced wit 
the path to your folder. 

2. Confirm that you want to change the AppData folder if it already exists. 

3. Repeat steps 1 and 2 for Node2. 

To change %appdata% directly: 

1. Find the key HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\User Shell Folders in 
the registry. 

2. If it doesn’t already exist, create a REG_EXPAND_SZ type variable with the name AppData in this key. Set its value to 
\\FC10ProcServer\ClusterTemp. 

3. Repeat steps 1 and 2 for Node2. 

Connecting the Processing Server Monitor  

To connect the Processing Server Monitor, choose a node to which the FC10ProcServer service will belong, then open the 
Processing Server Monitor on any computer in your LAN and add the clustered Processing Server. 
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Setting Up the Licensing Server  
The Licensing Server service can be added to the cluster identically to the Processing Server service.   
You can use separate serial numbers for each node or use a license with the same serial number for all nodes. 
The stations must be restarted after the service switches between the cluster nodes. The Processing Server stops and automatically 
starts in 5 minutes. The remote stations continue working with their tickets if the same serial number is used for all of the cluster 
nodes. 
A separate log file with page use statistics is created on each cluster node in the folder %alluserspro-
file%\ABBYY\FlexiCapture\10.0\Licenses. To obtain summary statistics, the values from all of the nodes must be added.  

Setting Up the Application Server (and clustering the Administration and 
Monitoring Console and Web Data Verification Station) 
The ABBYY FlexiCapture 10 Application Server can be deployed on an NLB cluster to balance workloads and speed up query 
processing. 
Detailed information about Network Load Balancing technology can be found on the Microsoft website. 

Setting Up an NLB Cluster for the Application Server  
In this section, you will find step-by-step instructions for setting up an NLB cluster for the Application Server. 
The Administration and Monitoring Console and Web Data Verification Station are clustered together with the Application Serv-
er.  
A detailed overview of NLB cluster settings can be found on the Microsoft website. 
Note. The addresses, computer names, domain names, etc. used below are not mandatory and may be changed by the administra-
tor. 

Setting Up the Cluster 
To set up the cluster, complete the following steps:  

1. Install the Application Server on each cluster node. The database, File Storage Folder, Processing Server, Licensing 
Server, and Application Server clients must be located on a different computer, which must be accessible to all nodes in 
the cluster. 

2. In Windows Features, add Network Load Balancing to each node in the cluster. This can be done by clicking the Add 
Features link in the main window of the Server Manager (Start > Administrative Tools > Server Manager). 

3. Assign an IP address to the cluster via which the cluster can access the nodes as a unit. (This is a virtual cluster address.) 
If a single network interface is used for client/cluster traffic and other network traffic on the nodes (as is usual in Multicast 
mode), each host in the cluster must have a dedicated IP address (in addition to the virtual address, which is common to all 
cluster nodes). A host will use its dedicated IP address instead of the virtual cluster address for incoming connections  to the 
cluster nodes over Telnet, SSH and other protocols, and for outbound connections from the cluster nodes. 
All cluster nodes must receive all incoming cluster traffic. The balancing algorithm determines which cluster node should re-
spond to a given query. The choice between Unicast and Multicast depends on your network configuration. 
4. You can use the Performance Monitor for IIS (accessible through the toolbar of the Microsoft Management Console 

(MMC)) to monitor node activity.  In the Web Service object, for each node, add the ISAPI Extension Requests/sec 
counter for Default Web Site (this is the location of the Application Server in the IIS). 

Selecting the Unicast or Multicast Method of Distributing Incoming Requests 
The choice between the Unicast and Multicast methods depends on your network configuration. A detailed description of the two 
methods can be found on the Microsoft website. 

http://technet.microsoft.com/en-us/library/bb742455.aspx
http://technet.microsoft.com/en-us/library/bb742455.aspx
http://technet.microsoft.com/en-us/library/cc782694(WS.10).aspx
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Balancing Workloads in the Cluster, Setting Up Hosts  
You can set up cluster traffic to be balanced and filtered by ports. 
ABBYY FlexiCapture 10 requires the TCP protocol for its operation. There are two filtering modes: Single Host and Multiple 
Host. 

• Single host 
This mode provides fault tolerance, but does not allow load balancing. Only one cluster node is active at a time. 

• Multiple host 
Traffic from a predefined range of ports is handled by the node with the highest priority in the cluster. All cluster nodes function 
simultaneously. 
This mode provides both workload balancing and fault tolerance. 
Traffic from a predefined range of ports is balanced among nodes. You can also set the Affinity parameter to: 

• None (not recommended) 
If this option is selected, multiple connections (TCP sessions) from a single client can be handled by different nodes. 

• Single (recommended) 
If this option is selected, all connections from a single client are handled by one node. 

• Network (Class C) (recommended) 
If this option is selected, all queries from the TCP/IP Class C address space are handled by one node. This may be ne-
cessary if there is a proxy server between the client and the cluster. 

Setting Up the Application Server 
Complete the following steps to set up the Application Server:  

1. Create a shared folder that can be accessed by all of the nodes in the cluster. 
2. Install Microsoft SQL Server. Microsoft SQL Server must be available to all cluster nodes. 
3. Install the Application Sever on all cluster nodes. 
4. On the first cluster node, run the Administration and Monitoring Console and create a database and specify a shared 

storage. 
5. On each of the remaining cluster nodes, run the Administration and Monitoring Console and connect to the database 

you created. 
Important! For this operation, SQL authentication must be used. 

6. On the SQL Server, give full access permissions for the database to all users on all cluster nodes under whose accounts 
IIS is running (the World Wide Web Publishing Service must be running in the service list). Permissions for the first 
node are given automatically when the database is created, other permissions must be given manually. By default, IIS 
runs under the user Network Service. In this case, assuming IIS is running on computer NodeN, you must give full 
access permissions to the user DomainName\NodeN$ on the SQL Server. 

7. If the Application Server is not unavailable in the cluster, but PING requests still reach the cluster, check if IIS is avail-
able in the cluster. To do this check, place a static *.html file in the folder %systemdrive%\inetpub\wwwroot (usually 
this folder already contains an iisstart.htm file) and open this file in a browser: \\ClusterAddress\iisstart.htm. Pay atten-
tion to the proxy server settings in your browser when opening the file. 

Running Server Application Clients 
We recommend that you place all cluster nodes in one domain and run Application Server clients under domain user accounts.  
Running Application Server clients under local user accounts is not recommended for the following reason. 
In the usual (i.e. non-clustered) configuration of the Application Server, the following authentication method may be used: on the 
computer where the Application Server is installed, a local user is created, with its own user name and password; now any client 
may connect to the Application Server under this user’s account. 
In a clustered configuration, the Application Server that processes client requests may be placed on different computers, and the 
actual user name will change accordingly: on the computer node1, the user name will be node1\User, while on the computer 
node2, the user name will be node2\User. This may disrupt the operation of the system. 
Running Application Server clients under domain users avoids this problem. 
To connect clients on remote computers which are not in the domain, you can use basic authentication and a user account in the 
domain to which the cluster belongs. Suppose the clustered Application Server is in the cluster domain and the computer of the 
verification operator is not in this domain. All you need to do is create in the cluster domain an account for the user clus-
ter\VerificationOperator and communicate the account name and password to the verification operator. Now the verification oper-
ator will be able to connect to the Application Server using this account and basic authentication on the Verification Station. 
Note. To use basic authentication for clients, be sure to enable basic authentication for the folder FlexiCapture10\Server in IIS. 
Otherwise, users will get HTTP 401 error when attempting to connect. 
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Technical Support 

Should you have any questions regarding the installation and use of ABBYY FlexiCapture 10, please contact the ABBYY tech-
nical support service or the technical support service of the ABBYY partner from which you obtained the software. For contact 
details, see the Technical Support section of the ABBYY website at www.abbyy.com. 
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